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PROLOGO

Los Ingenieros necesitan constantemente de la representacion
grafica para sus proyectos, por lo que urge el uso de software de
disenio de Ingenieria que permita a los ingenieros ser mds eficientes y
competitivos. Vista esta necesidad, la Universidad Nacional de Piura
y especificamente la Facultad de Ingenieria Civil que a través del
curso de Dibujo con Ordenador para Ingenieria Civil, da las

herramientas para el diserio de proyectos.

En aras de satisfacer la necesidad de contar con el material
adecuado para el aprendizaje del software Autocad por parte de los
estudiantes de Ingenieria Civil. Este manual cuenta con una
organizacion de los contenidos de forma tal que el estudiante empieza
con Ordenes muy simples hasta llegar a ordenes mds complejas. En
cada uno de los capitulos hablamos del fundamento teorico, luego un
ejemplo desarrollado y finalmente se presenta un ejercicio propuesto

para reafirmar los conocimientos impartidos.

El objetivo de esta investigacion estd esencialmente dirigido a la
capacitacion de los estudiantes principiantes ya que la investigacion
se desarrolla de forma muy explicita y didactica, de forma tal que sea

de facil entendimiento por parte de los alumnos.

Satisfechos y muy agradecidos por permitirnos contribuir con un
granito de arena a la formacion integral de los estudiantes de esta
alma mater.

Los Autores.
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Resumen

La tendencia de las carreras profesionales multidisciplinarias es
abrumadora y esto debido a la globalizacion de los conocimientos, de forma tal
que un estudiante de la Universidad Nacional de Piura debe recibir los mismos
conocimientos que un estudiante en una Universidad Extranjera, esto nos obliga
a los estudiantes y a los profesores a esforzarnos por ser competentes en
cualesquiera fuera nuestra especialidad. La tecnologia y el ordenador convertido
en casi una agenda para el profesional de hoy, obliga a considerarnos
analfabetos tecnoldgicos, si no se tiene conocimiento del uso adecuado de un
ordenador para un mejor desemperio profesional.

El curso de Dibujo con Ordenador para Ingenieros Civiles esta
estructurado en modulos de dificultad no creciente, sino complementaria. El
presente trabajo tiene por objetivo proporcionar informacion clara, precisa y
detallada sobre el uso de AutoCAD, software creado para el dibujo y diseiio
técnico de gran utilizacion en el mundo de la ingenieria, el conocimiento de éste
software abrira muchas puertas en el mundo laboral.

Con el unico proposito de que este trabajo cumpla el objetivo primordial de

contribuir al mejor aprendizaje de los alumnos de la especialidad de ingenieria
civil. Esperamos que sea de entera satisfaccion de los interesados.

Los Autores
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Abstract

The tendency of the multidisciplinary professional careers is
overwhelming and this due to the globalization of the knowledge, in such way that
a student of the National University of Piura should receive the same knowledge
that a student in an foreign University, this forces us to the students and the
professors to make an effort to be competent in any it was our specialty. The
technology and the computer converted in almost a calendar for today's
professional, forces to consider us illiterate technological, if one doesn't have

knowledge of the appropriate use of a computer for a better acting professional.

The course of Drawing with Computer for Civil Engineers is structured in
modules of you not hinder growing, but complementary. The present work has for
objective to provide clear, precise and detailed information on the use of
AutoCAD, software created for the drawing and technical design of great use in
the world of the engineering, the knowledge of this software will open many doors

in the labor world.
With the only purpose that this work completes the primordial objective of

contributing to the best learning in the students of the specialty of civil

engineering. We hope it is of whole satisfaction of the interested ones.

The Authors
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INTRODUCCION

La tendencia de las carreras profesionales multidisciplinarias es
abrumadora y esto debido a la globalizacion de los conocimientos, de forma tal
que un estudiante de la Universidad Nacional de Piura debe recibir los mismos
conocimientos que un estudiante en una Universidad Extranjera, esto nos obliga
a los estudiantes y a los profesores a esforzarnos por ser competentes en
cualesquiera fuera nuestra especialidad. La tecnologia y el ordenador convertido
en casi una agenda para el profesional de hoy, obliga a considerarnos
analfabetos tecnologicos, si no se tiene conocimiento del uso adecuado de un
ordenador para un mejor desemperio profesional.

Las escuelas y facultades de ingenieria de las universidades se ven
obligadas a incluir el manejo del ordenador como herramienta para el mejor
desempeiio del futuro profesional, por ello la carrera profesional de Ingenieria
Civil no escapa a esta realidad. Lo que nos impulsa al desarrollo de este trabajo,
el mismo que contribuird grandemente al aprendizaje de los alumnos de esta
especialidad.

El curso de Dibujo con Ordenador para Ingenieros Civiles esta
estructurado en modulos de dificultad no creciente, sino complementaria. El
presente trabajo tiene por objetivo proporcionar informacion clara, precisa y
detallada sobre el uso de AutoCAD, software creado para el dibujo y diserio
técnico de gran utilizacion en el mundo de la ingenieria, el conocimiento de éste
software abrira muchas puertas en el mundo laboral.

El curso requiere de un manejo apropiado de la diddctica por parte del
docente, ya que el estudiante recibe una gran cantidad de términos técnicos por
lo que requerira de un alto nivel de concentracion para un efectivo aprendizaje
por parte del estudiante. Por lo que se plantean una serie de ejemplos practicos y,
al final de cada modulo, se proponen ejercicios que seran resueltos por el
alumno. Es un curso eminentemente practico.

Por consiguiente, en el presente proyecto de investigacion titulado:
“MODULO DE PRACTICAS DE LABORATORIO DE DIBUJO ASISTIDO CON
ORDENADOR PARA INGENIEROS CIVILES (AutoCAD)”, se incluyen ocho
capitulos. El primero de ellos corresponde a los Fundamentos Teoricos, el
segundo, “Entorno, Utilidades, Formas de seleccion y Ordenes de Dibujo”; el
tercero, “Utilizacion de Ordenes de modificacion”; el cuarto, ‘“Textos,
Sombreados y Propiedades del AutoCAD”; el quinto, Dimensionado”; el sexto,
“Dibujos Isométricos”, el séptimo, “Multilineas”; el octavo y ultimo comprende
“Bloques”.

El capitulo primero correspondiente a Fundamentos teoricos abarca los
Antecedentes del Problema, Justificacion, Planteamiento del problema, Objetivos
y Metodologia a utilizar. En los siete capitulos siguientes, se describe el objetivo,
fundamento tedrico, materiales y equipos utilizados, problema resuelto y uno
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propuesto como evaluacion del alumno, Asi mismo, se incluye una serie de
Conclusiones y Recomendaciones al término del presente trabajo,

Con el unico proposito de que este trabajo cumpla el objetivo primordial
de contribuir al mejor aprendizaje de los alumnos de la especialidad de
Ingenieria Civil. Esperamos que sea de entera satisfaccion de los interesados.

Los Autores

CAPITULO |

FUNDAMENTOS TEORICOS

AutoCAD — INGENIERIACIVIL -10-
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1.1. ANTECEDENTES

La Facultad de Ingenieria Civil fue creada mediante Resolucion N° 003-
AU-96 del 17 de mayo de 1996, iniciando sus actividades académicas en
agosto del mismo aiio, siendo el Primer Presidente de la Comision de
Gobierno el Ing’ ZIVKO GENCEL M.Sc.

El segundo Presidente de la Comision de Gobierno fue el Doctor CARLOS
IBANEZ BURGA, docente principal de la Universidad Nacional de
Ingenieria quien desempenio el cargo desde Enero de 1997 al 31 de diciembre
de 1998. A la fecha cuenta con 12 docentes, 09 empleados administrativos y
300 alumnos aproximadamente.

Dentro de su estructura organica cuenta con 01 Departamento Académico
de Estructuras y Construccion creado mediante Resolucion de Asamblea
Universitaria N° 002-AU-97 , de fecha 08 de abril de 1997, 01 Centro
Productivo de Consultoria y Construccion — Laboratorio de Mecdnica de
Suelos, 01 Escuela de Maestria que cuenta con el Programa de Planificacion
Urbana y Regional , el Programa en Ingenieria Civil y actualmente cuenta
con un laboratorio de computo de 30 computadoras.

En el Plan Curricular de la Facultad de Ingenieria Civil existen dos
asignaturas relacionadas con el Dibujo: La asignatura de Dibujo Técnico
para Ingenieros Civiles cuyo objetivo es Proporcionar al estudiante el
conocimiento sobre el manejo del trazado geométrico que le permita resolver
y desarrollar las relaciones de una estructura tridimensional para que esté
en la capacidad de aplicarlas en la ingenieria de diserio de elementos de
maquinas, en el levantamiento de planos, en la matematica para el analisis
de los vectores, en el diserio de tolvas, en las conexiones de tuberias, etc. y la
asignatura de Dibujo con Ordenador para Ingenieros Civiles, e/ mismo que
se viene desarrollando actualmente, haciendo uso de las normas del
contenido del Silabo del curso, aplicando ejercicios de acuerdo a lo que el
Docente elabora.

1.2. JUSTIFICACION

Actualmente se vive en una era donde la computadora y las tecnologias de
la informacion se han inmerso dentro de todos los ambitos, por tanto los
futuros profesionales deben conocer y manejar software que les ayuden a
desarrollar mejor su trabajo. El avance tecnologico en grdficas en tiempo
real tiene su origen y sustento en el sistema CAD, existiendo en el mercado,
numerosos software para este fin, siendo uno de los mas utilizados el
AutoCAD donde se pueden realizar dibujos en dos dimensiones (2D) y en
tres dimensiones (3D).

Los alumnos del curso de Dibujo con Ordenador para Ingenieros Civiles,
no cuentan con una guia que les permita realizar la prdctica paso a paso y
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mas bien toman cualquier ejercicio, lo que hace que el alumno después de su
clase no tenga una ayuda que le permita practicar a fin de auto capacitarse,
por cuanto en el aula no cuenta con el tiempo suficiente para hacerlo. Con el
modulo se pretende que el alumno mejore su rendimiento y se cumpla con los
objetivos del curso.

La Facultad de Ingenieria Civil cuenta con su propio Laboratorio de
computo con 30 computadoras personales de ultima generacion para realizar
las clases practicas. Los alumnos matriculados actualmente son 60,
distribuidos en dos grupos de 30 cada uno.

En este mundo competitivo cada dia mas intenso, exige el apoyo constante
de las Tecnologias de la Informacion durante el desarrollo de sus clases,
para mejorar la metodologia de enserianza — aprendizaje. Con el desarrollo
del presente proyecto pretendemos ayudar en la elaboracion de la
mencionada guia con el fin de mejorar el proceso de ensefianza- aprendizaje.

1.3. PLANTEAMIENTO DEL PROBLEMA

De acuerdo a lo indicado en los Antecedentes, nos damos cuenta que los
alumnos de Ingenieria Civil, no tienen ninguna guia practica para afianzar
sus conocimientos de desarrollo — aprendizaje, de alli la necesidad que
aflora de contar con un modulo y guia de aprendizaje para los alumnos de tal
forma que les permita afianzar los conocimientos impartidos por los
docentes.

1.4. OBJETIVOS

OBJETIVO GENERAL

o Desarrollar un modulo de practicas de laboratorio para el curso de
Dibujo Asistido con Ordenador para Ingenieros Civiles que sirva de guia
para mejorar el proceso de ensenianza - aprendizaje.

OBJETIVOS ESPECIFICOS:

e Proporcionar al estudiante la guia de prdctica de laboratorio que debe
realizar, de acuerdo a los objetivos y contenidos planificados en el curso.

e Proporcionar ejercicios propuestos, para que el alumno pueda practicar
en horario extracurricular.

1.5. METODOLOGIA:

El proyecto a desarrollar se encuentra dentro del tipo de Investigacion
descriptiva y aplicada, pues se basara en documentacion bibliografica
existente y los conocimientos académicos de los responsables de proyecto.

AutoCAD — INGENIERIACIVIL -12 -
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La recoleccion de datos para la realizacion de esta investigacion se
basard en:

o FExplorar los diferentes sitios WEB con la finalidad de encontrar
informacion actualizada del tema.

e Visitar Bibliotecas con la finalidad de encontrar informacion
bibliografica que nos ayude en el desarrollo del proyecto.

AutoCAD — INGENIERIACIVIL
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CAPITULO I

“ENTORNO, UTILIDADES, FORMAS DE SELECCION
Y ORDENES DE DIBUJO”

2.1. OBJETIVOS

o Familiarizar al alumno con el entorno de Software AutoCAD.

Desarrollar conocimientos en procedimientos para ingresar ordenes,
entrada de datos.

Ayudas al dibujar: Limits, Units, Grid, Snap y Ortho.

Modos de referencia y de seleccion.

Ordenes de visualizacién: Zoom y Pan.

Ordenes de dibujo: Line, Rectangle, Circle, Arc, Elipse, Polygon, Point,
Polyline.

2.2. FUNDAMENTO TEORICO

Antes de empezar con el curso AutoCAD, es necesario familiarizarse con cada

uno de los elementos que contienen la ventana de dibujo, en donde vamos a
trabajar.

e Barra de menu.- barra horizontal en donde se encuentra las opciones:
File, Edit, View, Insert, Etc. Obsérvese la figura siguiente:

Ll AutoCAD 2008 - [Drawingl.dwg]

Ii File Edity View Inset Format Tools Draw Dimension Modify Express Window Help

oA\ R@ ¢, # € V-BERIYEA @] Dootngthromon - 1 |
T M Bylayer v | Bylayer  ~ || ByColor -

Barra de Menu

I

L\

e Barra de Herramientas Estandar.- Barra que se encuentra después de la
barra del menu, en esta barra se encuentran iconos como: New, Open,
Save, Etc. Obsérvese la figura siguiente.

o AutoCAD 2008 - [Drawingl.dwg]

I.:E. File Edit View Inset Format Tools Draw Dimension Modify Express Window Help

[DRAI2RR e R, # |- (CXARBEHIDE|B
Dpen...CTRL+D|v| ByLayer v” ByColor '||H=’$ o4

MO DA M E - E® | A LS| 1028 .

Barra Herramientas Estandar
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e Area de trabajo.- Es el drea de mayores dimensiones, por defecto es de
color negro y que es sujeta a variacion del color del fondo también
conocida como drea grdfica. En esta area se lleva a cabo el dibujo y
modificacion de las entidades. Obsérvese la figura siguiente:

2008 - [DrawingLdwg]

Type a questionfor help

[PRAIERDS|+#£VRERIUE|B]| Dodrtioan B

W Bylarr - Blam v | —Blae - || B -

/ y
7 %
= 8
s} &
= &
s %
9]
8 < . il
- Area de Trabajo i
o +
2 -
3 o
) Q
. ++
B r
" r
"
& |
A

Hnummamc save to C:\Users\MERCEDES\AppData\Local\Temp\Drawingl 1 1 1279.sv$ ... ~
(Conmand : -

jcommand: W
[3579.1624, 1944.855, 00000 _| SNAP| GRID| ORTHO| [PoLAR [osnap [oTRACK [Ducs [pvw LWT] [mopEL Amotation Scde: 11+ ¢ [g -

e Jcono de coordenada.- Nos indica en que coordenadas se estd trabajando.

Automatic save to C:\Users\MEFE
Command :

Cormmand :
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LABORATORIO DE AutoCAD DAII - UNP

Acceso a las ordenes de Autocad.- Hay tres maneras para empezar a
trabajar:

e Barra de herramientas

e Barra de menu

o Ventana de comandos

e Barra de herramientas del Autocad

Las barras de herramientas generalmente tiene el mismo nombre que los
menus o que algunas de sus opciones, asi por ejemplo existe una barra
llamada draw, modify, dimension, etc. Se activa cualquiera de las ordenes
a través de los iconos de las barras. Véase la siguiente figura.

i1 AutoCAD 2008 - [Drawingl.dwg]
"HEMMMWTMMMME@EMM Type a question

Dk EeRY ¢ +#|£- V- BERIVE|@| | Docgthmason  ~ 5 |
W Bylayer - | Blaywr v | Blayer v | EyColor -

Barra de dibujo
//Joﬂr"@faﬂoo@% -EELEA
Barra de edicién de entidades

Barra de acotado

Para activar las barras de herramientas:
e Hacer click derecho sobre una espacio libre donde estan
dispuestas las barras de herramientas.
o Luego ir a la opcion ACAD, y se desplegara una serie de barras de
herramientas teniendo la posibilidad de elegir la que se desee. Ver
figura siguiente:

AutoCAD — INGENIERIACIVIL -16 -
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pdty  Window n by T
CLCIELTY LI P
= iyl

HCHUICRE
A@FF||RVN{COL +PECHEE

z
|

[Ccmmand: COMMANDLINE

fCommand: Speeify oppesite corner:
fcommand: Specify opposite corner:
Jcommand: *Cancel® m
[Command: Specify opposite corner: =

T s ol T — &~ $a4 . |

{56d%

1

¢

e Barra de Menu
Permite acceder a las diferentes opciones, Se debe hacer clic en la opcion
del menu que desea (File, edit, view, insert, format, tools, draw, etc) y
veremos desplegar un conjunto de opciones las cuales también son sujeto
de seleccion. Observe la figura siguiente:

/" Ray
' Construction Line
Multiline
+2 Polyline
2, 2D Polyline
7 Polygon
=1 Rectangle
22 Helix
Arc
Circle
Donut
i~ Spline
Ellipse
Block
A Table...
Paint
2 Hatch...

e
e
=5
o}
o=
'
e}
v
)
>
w8l
2
B
4

e Ventana De Comandos.:

Se debe escribir la orden o comando y se ejecuta al presionar ENTER

/
[putoCAD menufutilities loaded.
ICommand: C DLINE
ICommand: Yine

[753.0128, 52768 ,0.0000 | SNAP| GRID| ORTHO| POLAR| [0SNAP OTRACK| DUCS| DYN| LWT| [MoDEL
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Configurar El Area De Trabajo

Units: Permite escoger las unidades en las que se va a trabajar

1. Ingresamos al menu principal Format y elegimos units.

2. Aparece un cuadro de didalogo tal como el que se muestra en la figura
3. Se seleccionan las unidades segun el trabajo que se desarrollara

o AutoCAD 2008 - [Drawingl.dwg]

E File Edit View Insert Tools Draw Dimension Modify Exg ™ Drawing Units
DWH &R S e 29

ﬁ Layer States M;

M Eylayer -| ByLayer

« Thickness
Drawing Limits

Units for specifying the intensity of lighting:

Lok J[ camsl [[ Orecion. J[ tep ]

Rename...

— Layer tools 4

/ Color...

/ Linetype...

o Lineweight...
Scale List...

o e

o B Tet Style...

(— ,A Dimension Style...

@ @ Table Style..

) £/ Multileader Style
Plot Style,,,

Ind Point Style...

o Multiline Style...

2

&)

)

>

o

haN

Se elige las unidades a trabajar como longitudes, la precision, unidades
que se conectaran a la escala, las unidades de medida de los dangulos, el
sentido de lectura de los angulos, etc. La eleccion de cada uno de las
opciones de éste cuadro de didlogo va a depender de las necesidades del
usuario.

Limits: Permite definir los limites de la hoja

1. Ingresamos al menui principal Format y elegimos limits

2. En la ventana de dialogo piden coordenadas de la esquina inferior
izquierda ingresamos (0,0) origen

3. luego la esquina superior opuesta e ingresamos cualquier coordenada,
pero usualmente se ingresa (210,297) que corresponde al formato de hoja
A4 en posicion vertical. Obsérvese la figura siguiente:

% Layer..

& Layer States Manager...
Layer tools
<

ineweight...
Scale List...

By Text Style...
& Dimension Style...
# Table Style...
£ Multileader Style
Plat Style..
Point Style...

B P00 LgeNIDLNN]
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ICommand: ' limits
[Reset Model s=pace limits:
Specify lower lefr corner or [ON/OFF] <0.0000,0.0000>: 0,0

Specify upper right corner «<420.0000,297.0000>: 420,237
1113.2368, 776.6713, 0.0D00 | SNAP| GRID| ORTHO| POLAR|[0sNAP OTRACK| DUCS| DYN| L

(210,297) (420,297)

A4 A3

297
297

©0,0) ©.0)

210 420

A2 A3

A4

210

297

594

En la barra de estado se encuentran las opciones Grid, Snap y Ortho y otras.

Butomatic save to C:\Users\MERCEDFS\arnDataiT.ncal\Temp\Drawingl 1 1 1279.:
Command : _~  Barrade Estado

ICommand :

[3237.4615. 12947419, 0.0000_| SNAP["GRID| ORTHO) [POLAR [OSNAP [OTRACK [DUCS [DYN LWT|[MODEL
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Grid: sirve para dibujar una rejilla de puntos que permitiran guiarte para el
dibujo que se esta realizando.

1. Enla barra de estado se hace click derecho sobre grid luego click derecho
en Settings, y obtendremos un cuadro de didlogo como el que se observa
en la figura.

2. de la opciones elegimos un intervalo cualquiera (10) para el caso del
sistema decimal.

3. Para hacer las modificaciones del snap podemos hacer las variaciones en
el mismo cuadro de dialogo que se muestra.

Snap: sirve para desplazar el cursor solo en los puntos del grid.
Ortho: sirve para desplazar el cursor en lineas horizontales y verticales.

Existen algunas teclas abreviadas para activar/desactivar tanto el Grid, Snap
como Ortho, que son f7, 9 y 18 respetivamente.

Snap and Grid ‘Fda’demg |Q;‘m5hm |Dmaﬂcml‘

Snap On (F3) Giid On (F7)
Snap spacing (Gid spacing
Snap X spacing: (Giid X spacing
Snap Y spacing: 10 Grid Y spacing
Equal X and Y spacing Wajr e every
LRI Layoutl § Layout? Potr spacing id behavir
[Enter new value for THICI e e D L )
ICommand: Specify opposit S :g;,g T
\Command : [ @ Grid snap
- @ Red Display grid beyond Limits
15300542, 200.6343,0.0000 | SNAP S IF Folow Dyraric UCS
FARTT e o

(7) PolarSnap

Osnap: modos de referencia sirve para dibujar una entidad con mayor
precision ya que cuando se necesita tomar un punto especifico de otra
entidad. Autocad cuenta con los modos de referencia como: endpoint,
midpoint, perpendicular, tang, center, node, etc. Podemos accesar a ellos
haciendo click derecho sobre la barra de estado en el icono Osnap, haciendo
click derecho en Settings. Véase la figura.

M) Ap b Layout] / Layout?

LSpecify radius of circle: *Cancel®

|Command :

0, -10.0000,00000 |[snap [GRID ORTHO| POLAR [0S

= T Trabajo d ga
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En esta ventana podemos activar los modos de referencia que se desee segun la
necesidad del usuario. Ver figura adjunta.

[ Sn=p and Gid [ Polar Tracking | Obiect Srp | Bynamic Input]
(7] Obiect Snzp On F3) [ biect Snap Tracking On F11)
Object Snap modes
(9] Endpoirt [ insertion
[¥] Midpoirt [¥] Perpendicular
[ Center [T Tangent
[[I Node [ Nearest

[ Guadrant [T Apparert intersection

[#] Intersection [ Parallel
To track from an Osnap point. pause over the peint while in a

command. Atracking vector appears when you move the cursor.
To stop tracking, pause over the poirt again

Visualizacion.- Es necesario saber que el Autocad cuenta con drdenes para
visualizacion de las entidades que se dibuja, siendo las indispensables para el
aprendizaje inicial Zoom y Pan. Cuya ubicacion se muestra en la figura
siguiente:

- [Drawingl.dwg]

i) Aute

8 - [Drawingl.dwa]

Insert Format Tools Draw Dimension Modify Express R File Edit Insert Format Tools Draw Dimension Modify
o fedraw £-) - gxa®) D& R B FERRL L
g:ml - | Bylayer = || € W Bylaper xﬁ:é“ - ByLayer
by — . | e Lah 7P ySlCTelolidh
/ o = 7 Pz e
o Foint
f (;;:“Ela 4 @‘ o . / Camera (1
4 Walk and Fly o Eormne = Walk and Fly Sl
a Acrial Vi I < G S Bate
= e e @, Center = B —
- Clean Screen CTRL+0 | @, Object 7 Clean Sgreen CTRL+0 | %) Down
@ Viewports V& I @ Viewports 4
%) Named Views... @, out ] Named Views...
— 3
P 3D Views N 30 Views
< ﬂ Create Camera o il Create Camera
el Show Annotative Objects ’ ” Show Annotative Objects ~ *
8l B Hide E W Hide
? Visual Styles 4 ) Visual Styles 4
- Render 3 Render 4
= % Motion Path Animations... 31 4 Motion Path Animations...
® Display 4 o Display '
- Toolbars.
Toolbars... = o
=)
A A

Donde cada una de las opciones tienen sub opciones distintas referentes a la
visualizacion que el alumno debe explorar para que vea su mejor aplicabilidad.
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Ingreso De Datos

Existen dos métodos de ingresar datos:

1. Utilizando el Mouse al hacer clic en el punto deseado y este punto sera una
referencia valida para el programa aunque no muy exacta. (la exactitud se
lograra con los modos de referencia y las ayudas de dibujo para encontrar
puntos especificos)

o
[
=
B
=
|
&
A

pecify next point or [Undo]:
Specify next point or [Undo]:

Utommand: _line Specify first point: <«Snap on>
5

ISpecify next point or [Close/Undo]:

60.0000, 70.0000 , 0.0000 SNAP [GRID ORTHO| POLAR| [0SNAP OTRACK| DUCS| DYN| LwT|[MoDEL

2. Utilizando el sistema de coordenadas, el cual puede utilizarse en dos estilos

diferentes:
a. Coordenadas Cartesianas: este estilo es el universal y se basa en los
ejes (X,y)

e Coordenada Cartesiana Absoluta: (4,6)(5,-2)(-9,21)
o Coordenada Cartesiana Relativa: (@3,4) (@5-,9) (@-18,10)

Obsérvese su uso en ejemplo que muestra la figura

P

370

R.
/ 120 40
e

o Absolutas: P; —(120,50)
e Relativas: P, —(@40,30)

30

50
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b. Coordenadas Polares: este estilo se basa en una distancia y angulo.
Este tipo de coordenada también cuenta con dos subtipos

o Coordenada Polar Absoluta: (4<60)(5<-37)(8<65)
e Coordenada Polar Relativa: (@3<45) (@®5<75) (@-18<53)

=

370

A
R
L /‘ 120 - 40

o Absolutas: P; —130<23°
e Relativas: P, »@50<37°

30

50

Uso De Herramientas Basicas

Line: sirve para dibujar una linea o varias lineas consecutivas.
1. Activamos la orden linea a través de cualquiera de las tres posibilidades
que existen.

4 008 - [Drawingl.dwg]
™ File FEdit View Inset Format Tools

f:ﬁ, File Ed'rt View 1n rmat Tools [Draw | Dimension Modify Expres
[DREIeRD (<R G 4 Moding 'R
= -] amJ |
HAFHIODOAINRE /‘ A

Construction Line

[o%AleR2 e <.
|| mBytayer «| Byl

MY 7RO POAINET

7 Multiline
Ve > Polyline
2 2 3D Polyline
O O Polygon
- I Rectangle
r £ Helix

-“Command: Line

Specify first point:l

140.0000, -10.0000, 0.0000 | [SNAP [GRID ORTHO| POLAR|[OSNAP !
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2. Especifica primer punto(2,5)

3. Luego sigue solicitando mdas coordenadas para el dibujo: specify next
point or [undo], ingresamos datos a través del teclado haciendo uso de
las formas polares y cartesiana tanto absolutas como relativas segun sea
el caso y la necesidad del usuario.

P

LineJ

Specify first point: P; {primer punto}

Specify next point: P, {siguiente punto}

Specify next point: P; {siguiente punto;}

Specify next point or [Close/Undo] :c {se cierra el poligono}
Podemos usar undo para deshacer el ultimo trazo.

Rectangle: se necesita de dos puntos para dibujar un rectangulo, estas son
esquinas opuestas.

1. Activar la orden rectangle

2. Especifica primer punto: specify first corner point or [chamfer /elevation/
fillet/ thickness /width] escribir una coordenada o hacer clic.

3. Luego se solicita el segundo punto para el rectangulo specify other corner
point, la otra coordenada y listo.

Obsérvese las figuras siguientes:

008 - [Drawing1.dwal
M File Edit View Inset Format Tools

IoRBleR $|sz|E
M ByLayer - ByLa

" Construction Line
Multiline

-5 Polyline

2, 3D Polyline

e
7
o
a
=
's
@
¢!

RIEIC] Layout] f Layout2

[command: _rectang
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:

Specify other corner point or [Area/Dimensions/Rotation]:

:Bﬁ.iﬁw. 11.8683 , 0.0000 SNAP| GRID| ORTHO| [POLAR |OSMAP OTRACK| DUCS M LWT| |MODEL
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Circle: Esta orden de dibujo tiene diversas alternativas, la mds utilizada
solamente necesita centro y radio, para dibujar el circulo.
1. Ingresa a activar la opcion circle haciendo uso de cualquiera de la tres
posibilidades para activar las ordenes.
2. Si activamos la orden a través del teclado o a través de los iconos de la
barra de dibujo, el comando solicita que se ingrese el punto central para
circulo o [3P/2P/Ttr (Tan, tan, radio)], tal como se ve en la figura.

>EP A

Command: circle Specify center point for circle or [3F/2P/Ttr (tan tan radius)]:

[58.6641, 264208, 0.0000 | SNAP| GRID| ORTHO| [PoLAR [0SNAP OTRACK| DUCS| DYN| LwT|[MODEL

Si se hace uso del menu principal encontraremos otras opciones, las
cuales el usuario debe seleccionar segun sea el caso, como se presentan
en la siguiente figura:

)08 - [Drawingl.dwg]
a File Edit View Insert Format Tools Di i Modify Express Window Help
JJDﬁE'&aQ’|/#|f Modeling ’H|ﬂ|JJ|2DDraﬁ.ing&ﬂnnotation v|m}
/ Line
/" Ray
/" Construction Line
Multiline

—= Polyline
2 3D Polyline
(J Polygon
[T Rectangle

= Helix

Arc

[ (2 Center, Radius
@ Donut @ Center, Diameter

r~/ Spline ®

Ellipse :
- 3 Points
Block o =

@ Tan, Tan, Radius

Table...
@ Tan, Tan, Tan

Point
12 Hatch...

l Gradient...

H Boundary...

Region
Wipeout

€3 Revision Cloud

>EHPME - dHO0LOONTOLNN|

Text
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Arc: Puede crear arcos de varias maneras. Con la excepcion del primer método,
los arcos se dibujan en sentido contrario a las agujas del reloj desde el punto
inicial al punto final.
Al activar la orden Arc a través del menu principal podemos tener acceso a todas
las posibilidades que el software presenta para la ejecucion del mismo, el usuario

debe hacer uso de ellas de acuerdo a las necesidades que éste tenga:

il rawingl.dwg]
a File Edit View Inset Format Tools Di i Modify Express Window Help

|D R A2 BD ®| s F| £ Moding ’h||” 20 Dratting & Annotation
W ByLayer - | Bylay

/ Construction Line
Multiline

+2 Polyline

2, 3D Polyline

O Polygen

T Rectangle

25 Helix

D/~ 2 Points

Circle
@ Donut
~ Spline

Ellipse
Block ¥| /% Start, End, Angle
¥ Start, End, Direction
, {71 start, End, Radius

»
£ Start, Center, End

¥, Start, Center, Angle

b &, Start, Center, Length

H Table...

Point
1 Hatch...

l Gradient...

H Boundary...

Region
Wipeout

£3 Revision Cloud

{7, Center, Start, Angle
{7, Center, Start, Length

rEPEE - a0 0LOCNICL NN

[+ Continue

Dibujo de arcos especificando tres puntos
Puede dibujar un arco especificando tres puntos. En el ejemplo siguiente,
el punto inicial del arco se fuerza al punto final de una linea. El segundo
punto del arco se fuerza al circulo medio de la ilustracion.

el punte final de= ba
linea
= .
{~ 3Points
1 3

Dibujo de arcos especificando el inicio, el centro y el fin
Cuando conoce el punto inicial, el punto central y el punto final, puede
dibujar un arco especificando primero el punto inicial o el punto central.
El punto central es el centro de un circulo del que el arco forma parte.
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f’-: Start, Center, End s . Center, Start, End

1 3
.
1
3 2
inicio {1), cenira (3. fin {3) eenino (1), ko (), 86 3

e Dibujo de arcos precisando el inicio, el centro, y el &ngulo
Cuando tenga un punto inicial y un punto central al que pueda forzar el
cursor y conozca el angulo incluido, utilice las opciones Inicio, Centro,

Angulo o Centro, Inicio, Angulo.

ﬁ_ Start, Center, Angle

El angulo incluido determina el punto final del arco. Utilice el método
Inicio, Fin, Angulo cuando conozca ambos puntos finales pero no puede

forzarse a un punto central.

;"'H-_ Start, Center, Angle

/W Start, End, Angle
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{'rf_ Center, Start, Angle

inicip, gentig, dromie

Dibujo de arcos especificando el punto inicial, el centro y la longitud
Cuando tenga un punto inicial y un punto central al que pueda forzar el
cursor, cuando conozca la longitud de la cuerda, utilice las opciones
Inicio, Cen, Longitud o Cen, Inicio, Longitud.

;57_ Start, Center, Length

ongited de la cuerda
1 1
2
—— lorgitud 4o 13 cmevila
Lovein, eenlve larciud ceste. inicin, longited

La longitud de la cuerda del arco determina el dngulo incluido.

Dibujo de arcos especificando el punto inicial, el final y la direccion o el
radio

Cuando tenga un punto inicial y un punto final, utilice las opciones Inicio,
Fin, Direccion o Inicio, Fin, Radio. La ilustracion de la izquierda muestra
un arco dibujado mediante la definicion de un punto inicial, un punto final
vy un radio. Puede especificar el radio, bien indicando una longitud, bien
desplazando el dispositivo serialador en el sentido que marcan las agujas
del reloj o en sentido contrario y haciendo clic para especificar una
distancia.
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/71 Start, End, Radius

' Start, End, Direction

. . mﬂ?/,ﬂ.

1
inic < Fa. sagie inicic. Iy, degocin

La ilustracion de la derecha muestra el dibujo de un arco llevado a cabo
haciendo uso del dispositivo sefialador para especificar el punto inicial, el
final y la direccion. El desplazamiento del cursor hacia arriba a partir de
los puntos inicial y final dibuja el arco concavo con respecto al objeto, tal
y como aparece mas adelante. Si desplaza el cursor hacia abajo, el arco
se dibuja convexo en relacion con el objeto.

Elipse: La forma de una elipse viene determinada por dos ejes que definen de
diametro mayor y el diametro menor. El eje mas largo se denomina eje mayor,
mientras que el mds corto recibe el nombre de eje menor.

ingresa elipse

ingresamos punto final de eje de elipse: 50
otro punto final: 20

distancia de otro eje: 25

AN~

med
dell peirmes gje e
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Polygon: Puede crear rectangulos y poligonos regulares de una forma rapida. La
creacion de poligonos es una forma sencilla de dibujar triangulos, cuadrados,
pentdgonos, hexagonos y otras figuras equildteras.

1. Activamos la orden polygon a través de cualquiera de las posibilidades

existente el ordenador solicitard el numero de lados del poligono.

luego precisa el centro de poligono o [Lado]: 7

elegimos una opcion [Inscrito en el circulo/Circunscrito alrededor del

circulo] <I>: |

4. Precise radio de circulo con herramientas auxiliares para encontrar
puntos especificos con intersecciones, punto medio, etc. O con
coordenadas. Véase la figura siguiente:

“w N

rEFRE- s HI0LOEGNDOL

I

fommand: _polygon Enter number of sides <d>: 7

[ipecify center of polygon or [Edge]:

[Eater an epeion in eirele/Ci about circle] <I»: i
lspecify radius of circle:

Point: Esta orden grafica puntos, los estilos y tamanios de puntos que se desea
usar seran escogido por el usuario ya que es posible el formateo de los mismos.
Véase la siguiente figura:

P File Edit View Insert [Format| Tools Draw Di

Mo
DR E| &R S Laye =
JJ M Bylayer - ﬁﬁ:l‘z‘: Manager... o
HAFHIOPE  coor.

Linetype...
Lineweight...
Scale List...

B Text Style...

& Dimension Style...

# Table Style...

B4 Multileader Style
Plot Style..,

Mul tyle...

Units...
=2 Thickness
Drawing Limits

Z:-ado 010000 LNN\]|
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En la ventana de dialogo que se muestra a continuacion observamos los tipos de
puntos que podemos seleccionar, ademdas de darle el tamarnio y escoger si el
tamanio es relativo o absoluto segun sea el caso.

M Point Style

@)
[]
&

Poirt Size:  5.0000

(@) Set Size Relative to Screen
() Set Size in Absolute Units

[ ok J[ Cacel [ heb

1. Activamos la orden Point a través de cualquiera de las posibilidades
existente el ordenador.
2. Ingresaremos las coordenadas segun los requerimientos.

)08 - [Drawingl.dwgl
i Modify Express Window Help
D@2 RAD E|=D G o Moding AXIET LY 1
mBLayer - Bylay . Line =l
HY 72O 20 AlRE RS L | som

" Construction Line
Multiline

&g

.3 Polyline
2, 3D Polyline

> EHpP e -

- Muttiple Point

#h Divide
5 Measure

>EHPME - a0 0TOOND O LN

|Chrrent point modes: PDMODE=35 PDSIZE=5.0000
Specify a point: 50,80

€3 Revision Cloud

ll |Command :

1000000, 130.0000, 00000 | [swap [GRID ORTHO| POLAR[osaP OTRACK D

[Current point modes: PDMODE=35 PDSIZE=5.0000
Specify a point: 50,80

[command :

Creates a point object: POINT

La orden punto me permite graficar puntos para lo cual muestra varias opciones
como: single point, multi point, divide y measure. Las dos primeras opciones
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grafica puntos sin guardar ningun criterio pre establecido ya los criterios los
establece el usuario, las otras dos opciones tienen criterios pre establecidos.

Divide.- permite trazar puntos de tal forma que segmenta a una entidad en un
numero de partes iguales que el usuario escoge.

@
2
~
o
o
18]
B
=
"
=
A

Command: divide
Select object to diwvide:
Enter the number of segments or [Block]: 9

ICommand =

370.0000, 60.0000, 00000 |[sNAP [GRID ORTHO| POLAR|[osnAP OTRACK| DUCS| DYN| LwT| [MODEL

Measure.- permite trazar puntos de tal forma que se gradiua una entidad en
intervalos de longitud que el usuario escoge.

>HPHA - aHI0CLIONI

ommand: measure
Select object to measure:
Specify length of segment or [Block]: 25

ICommand =

370.0000, 90.0000 , 0.0000 SNAP [GRID ORTHO| POLAR| [0SNAP OTRACK| DUCS| DYN| LWT] [MODEL
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Polyline: Objeto compuesto por uno o varios segmentos de linea conectados o de
arcos circulares tratados como si fueran un solo objeto.

~

Activar Polyline

2. Indicar primer punto: specify first corner point, siguiendo las
indicaciones de la ventana de didlogo, se ejecutara la orden segun el
requerimiento del usuario, ver figura adjunta.

>HPHMHE - 8800

ICommand :

ICommand: _pline

Specify =start point: 2,5

ICurrent line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 100,70
Specify mext point or [Arc/Close/Halfwidth/Length/Undo/Widch]: 150,5
Specify mext point or [Arc/Close/Halfwidth/Length/Undo/Width]: a
Specify endpoint of arc or

ll|[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second pt/Undo/Width]:
[201.7881, 614568, 0.0000 | SNAP| GRID| ORTHO| [PoLAR [DSNAP OTRACK| DUCS| DYN| LWT| [MODEL

2.3. MATERIALES Y EQUIPOS

o  Modulo AutoCAD
e Programa AutoCAD
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2.4. EJERCICIOS RESUELTOS

1455

36,38

D E F

65

15

T

Observamos que en este grafico se han usado varios comandos, antes de empezar
el trabajo seleccionamos la barra de herramientas DIBUJO, pasos a seguir:

1. La configuracion de la hoja de autocad, escoger las unidades y los limites
del dibujo: format>units, en la ventana de dialogo que aparece escogemos
las unidades decimales y milimetros. Para escoger los limites del dibujo:
format>dawing limits, en la ventana de dialogo a la solicitud de ingreso
de datos debe colocarse: 0,0 luego intro, posteriormente vuelve a solicitar
la esquina opuesta: 420,210 luego intro.

2. Las ayudas de dibujo grid y snap, deben colocarse en valores de 10 para
ambos casos.

3. activamos el modo ortho
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4. seleccionamos line y ubicamos todas las medidas dadas horizontales y
verticales segun sea (empezamos por el borde y después por la parte
interna).

e Seleccione line.

o Ubicamos el primer punto A, verticalmente 210, luego
horizontalmente 145.5 y asi sucesivamente hasta formar un
rectangulo.

o Seleccione line, luego ubique los puntos medios con ayuda de los
modos de referencia (Osnap), de los lados del rectangulo tanto en
forma vertical como horizontal y se unen con los lados opuestos,
con lo que obtenemos una division del rectangulo en 4 partes
iguales.

5. Luego unimos con linea los puntos B y J, siempre usando los modos de
referencia.

6. Seleccionamos arc con las opciones centro y radio, sefialando el centro en
el punto A y el radio perpendicular a la linea BJ. Se repite lo mismo para
el punto C.

7. Usamos la orden polyline y con punto inicial en la interseccion de la linea
BJ y el circulo con la funcion ortho activa trazo un segmento horizontal
de 15 y luego verticalmente 15, luego horizontalmente 15 y luego

activamos “a” de arco para luego trazar el arco hasta que haga contacto
con el lado del rectangulo ABCJ. Se repite para el lado opuesto.

8. Seleccionamos rectangle
e Precise primera esquina o
[Chamfer/Elevation/Fillet/Thicknees/Width] : punto D.
e Precise otra esquina o [Area/Dimensions/Rotation]: d (de dimension)
e Precise longitud del rectangulo: 36.38
e Precise ancho del rectangulo: 65

9. seleccionamos ellipse
e Precise punto final de la accisa de la elipse o [Arc/Center]: ¢
e Precise punto central de la elipse: punto O
e Precise punto final de la accisa: punto medio del lado del rectangulo.
e Precise el otro punto de la accisa de la elipse: punto medio del otro
lado del rectangulo.

10. seleccionamos line
e Precisamos el punto inicial: punto C
e Precisamos el punto siguiente.: punto F.

11. Seleccionamos arc, usamos la opcion Start, Center y End.
e  Punto inicial: punto E
e Punto central: punto F
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e Punto final: punto G. Repita el proceso para el lado opuest.

12. Seleccione circle
e Precise el centro: punto G
e Precise el radio: 20

13. Seleccione line
e Precisamos punto inicial: punto J

e Precise punto siguiente: punto H. Repite el proceso para la otra
diagonal del rectangulo.

14. Seleccione circulo
e Precise centro del circulo: escoja la interseccion de las diagonales
con el modo de referencia interseccion.
e Precise el radio, que como no es conocido opte por usar el modo de
referencia tangente a uno de los lado de mayor longitud del
rectangulo.

15. Seleccione poligono
e [Indicar el numero de lados: 7
o Luego indique el centro del poligono o [Lado]: centro del circulo
e Indique una opcion [Inscrito en el circulo/Circunscrito alrededor del

circulo] : i
e Precise radio de circulo: precise el mismo radio del circulo anterior y
listo.
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2.5. EVALUACION
Desarrollar La Siguiente Figura
30.00
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CAPITULO I11
“UTILIZACION DE ORDENES DE MODIFICACION”

3.1. OBJETIVOS

e  Ordenes de modificacion: erase, move, copy, rotate, scale, mirror,
array, trim, break, extend, fillet, chamfer, offset, explode, undo.

3.2. FUNDAMENTO TEORICO

Las herramientas tienen su propia barra y su propio Menu, las herramientas
que veremos Son:

e  Erase: Puede borrar objetos del dibujo a través de diversos métodos.
e Puede borrarlos mediante Erase, haciendo uso del comando a través
de las tres posibilidades de acceder a las ordenes de autocad.
e Puede designarlos a través de pinzamientos y cortarlos en el
Portapapeles mediante CTRL+X.
o Puede designarlos y pulsar la tecla Supr.

1. Seleccionamos erase
2. Luego seleccione el objeto a borrar
3. Pulse INTRO cuando haya acabado.
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e Move: Puede desplazar objetos a una distancia y direccion
determinadas de los originales.

it View Insert Format Tools Draw Dimension Express Window Help

12D C (=G 72 £ -

Bylayer ~ |
| © PO AINE MIE - E®

lirror

Haga clic en el menu Modificar » Move.

Seleccione los objetos que desee desplazar.

Precise un punto base para el desplazamiento.

Designe un nuevo punto de ubicacion del objeto seleccionado.

N~

Los objetos designados se desplazan a la nueva posicion, que viene
determinada por la distancia y la direccion entre los puntos primero y
segundo.

1
g .
R s
objetos seleccionados puerta movida con resultado
mediante seleccién de modo Orto activado y
captura enirada directa de

distancia

o  Copy: Puede duplicar objetos a una distancia y direccién determinadas de los
originales.

Los dos puntos precisados definen un vector que indica la distancia y la
direccion a la que deben desplazarse los objetos copiados.

Si pulsa INTRO en la solicitud del segundo punto, el primer punto se
interpretara como un desplazamiento X,Y,Z relativo. Por ejemplo, si
precisa 2,3 como punto base y pulsa INTRO en la siguiente solicitud, los
objetos se copian 2 unidades en la direccion X y 3 unidades en la
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direccion Y desde su posicion actual. El comando COPIA se repite para
mayor comodidad. Para salir del comando, pulse INTRO.

Seleccione Copy.

Designe los objetos que desee copiar.

Precise punto base o [Desplazamiento]

Precise segundo punto o [Salir/Deshacer] y luego Pulse INTRO.

ANwh~
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ommand: copy
ISelect objects: Specify opposite corner: 1 found
iSelect objects:
rrent settings: Copy mode = Multiple
ISpecify base point or [Displacement/mOde] <Displacement>: Specify second point
or <use first point as displacementi:
ISpecify second point or [Exit/Undo] <Exit>:

ISpecify second point or [Exit/Undo] <Exit>:

[295.2341, 648715, 00000 | SNAP|[GRID ORTHO| POLAR) [osnaP OTRACK] DUCS| DYN| LWT| [MODEL

Copia Unitaria

Commando: Copy

Select object: {selecciones los objetos que desea copiar}, luego Intro
Specify base point or [Displacement/mOde] <Displacement>: P;.
Specify second point of displacement or <use first point as
displacement>: P, luego Intro.

POONMPE

Copia Multiple

Commando. Copy

Select object: {selecciones los objetos que desea copiar}, luego Intro
Specify base point or [Displacement/mQOde] <Displacement>: P,.
Specify second point of displacement or <use first point as
displacement>: P,

Specify second point or [Undo/Exit] <Exit>: P;

Specify second point or [Undo/Exit] <Exit>: Py

7. Si se desea concluir con la orden E, luego Intro.

PonE

oo
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MERCEDES\Documentsdibujos alzamora.dwg]

Format Tools Draw Dimension Modify Window Help Express
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e Rotate: Los objetos incluidos en un dibujo se pueden girar alrededor de
un punto base especificada.

1. Haga clic en el menu Modificar » Rotate.
2. Designe el objeto que desee girar.
3. Especifique el punto base de la rotacion.
4. Realice una de las siguientes acciones:
» Indique in angulo de rotacion.
» Arrastre el objeto en torno a su punto base y especifique la
posicion del punto hacia la que desea que gire el objeto.
» Escriba C para crear una copia de los objetos designados.
= Escriba t para girar los objetos designados desde un dangulo de
referencia especificado hasta un angulo absoluto.
2
‘A\ B E A8 E i E
1
objeto punto base y angulo de resultado
seleccionado rotacién

e Scale: Mediante escala, puede hacer que el tamaiio de un objeto
aumente o disminuya de manera uniforme. Para atribuir una escala a un
objeto, debe precisar un punto base y un factor de escala. También
puede especificar la longitud que se debe usar como factor de escala en
funcion de las unidades de dibujo actuales.
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Haga clic en el menu Modificar » Scale.

Designe el objeto al que desee atribuir una escala, presione enter.
Precise el punto base (specify base point).

Indique el factor de escala o arrastre y haga clic para especificar una
escala nueva.

N~

e Mirror: Es posible pasar de un objeto a otro sobre un eje determinado
para crear una imagen simétrica reflejada.
La reflexion en simetria resulta util para crear objetos simétricos, ya
que puede dibujar rapidamente la mitad del objeto y después reflejarlo
en vez de dibujar el objeto entero.
Para reflejar objetos en simetria

Haga clic en el menui Modificar » mirror

Designe los objetos que desee reflejar en simetria.

Precise el primer punto del eje de simetria.

Designe el segundo punto.

Pulse INTRO para conservar los objetos originales n, escriba Y para
borrarlos.

SR N~
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TIEIEAL] Layout1 { Layout2

[Command: Specify opposite corner:

Icommand: *Cancel*

Icommand:

Icommand:

lcommand: mirror

Select cbjects: Specify opposite cormer: 5 found
Select cbjects:

Specify first point of mirror line: Specify second point of mirror line:

239.9953, 233.3147.00000 | snap|[GRID [ORTHO POLAR[0sNAP OTRACK] DUCS| DYN| LWT| [MODEL
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[Command :

[Command :

ICommand: mirror

Select objects: Specify opposite corner: 5 found

ISelect objecta:

Specify first point of mirror line: Specify second point of mirror line:
[Erase source objecta? [Yes/No] <N>: n

[Command :

4989644, 178.7486.0.0000 | SNAP| [GRID [ORTHO FOLAR| [osap OTRACK| DUCS| DYN| LWT| [MoDEL

e Array (matriz): Permite crear una copia multiple al mismo tiempo de un
objeto.este proceso de copia puede ser rectangular (filas y/o columnas)

@ Rectangular Amay () Polar Amay

| Rows: 5 | Columns 4

Offset distance and direction

Row offset: 17 ﬂ El
Column offset: 25 EI
N

Angle of amay:

By default, if the row offset is negative,

rows are added downward. K the

column offset is negative, columns are
TP added tothe left
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Creacion de Array rectangular

~

Haga clic en el menu Modificar » Array.

En el cuadro de didlogo Array, seleccione Array rectangular.

3. Haga clic en Designar objetos. Se cierra el cuadro de dialogo Array.

Se le solicitard que designe los objetos.

Designe los objetos para crear la matriz y pulse INTRO.

5. En los cuadros Filas y Columnas, escriba el numero de filas y
columnas de la matriz.

6. Especifique el espaciado horizontal y vertical (desplazamientos) entre

los objetos utilizando uno de los métodos siguientes:

N

RaN

»  En los cuadros de desplazamiento entre filas y columnas, escriba
la distancia entre filas y entre columnas que desee. Afiadiendo un
signo mas (+) o un signo menos (-) determinara la direccion.

*» Haga clic en el boton Designar ambos desplazamientos para
utilizar el dispositivo senalador y especificar las esquinas
diagonales de una celda de la matriz. La celda determina el
espaciado vertical y horizontal de las filas y columnas.

* Haga clic en el boton Designar desplazamiento entre columnas o
Designar desplazamiento entre filas para utilizar el dispositivo
senialador y especificar el espaciado horizontal y vertical.

El cuadro de ejemplo muestra el resultado.

7. Para cambiar el angulo de rotacion de la matriz, escriba el nuevo
dngulo junto a Angulo de matriz.

8. El pardametro por defecto de la direccion del angulo 0 también se
puede modificar mediante unidades.

9. Haga clic en Aceptar para crear la matriz.

ajﬁc'

0290 o

Creacidn de Array polar (alrededor de un circulo imaginario o real)

Al crear una matriz polar, dicha matriz se dibuja en el sentido de las
agujas del reloj o en el contrario, segun introduzca un valor negativo o
positivo para los grados cubiertos.

O
P
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A W Array

(") Rectangular Amay @ Polar Amay _’& Select objects

1 objects selected
Center point: * 140 - 100

Method and values
Method:
[Tutal number of tems & Angle to fil

Total number of tems: 10
Angle to fill: 160

Angle between items:

| For angle to fill, a posttive value specffies
2 counterclockwise rotation. A negative value
specifies clockwise rotation.

Tip

|¥] Rotate items as copied

Haga clic en el menu Modificar » Array.

En el cuadro de didlogo Matriz, seleccione Array polar.

En Centro, siga uno de los procedimientos siguientes:

»  Escriba un valor X y un valor Y para el centro de la matriz polar.

»  Haga clic en el boton Designar centro. Se cierra el cuadro de
dialogo Matriz y se le solicita que designe los objetos. Utilice el
dispositivo sefialador para designar el centro de la matriz polar.

Haga clic en Designar objetos. Se cierra el cuadro de didlogo Matriz y

se le solicita que designe los objetos.

Designe los objetos para crear la matriz.

En el cuadro Método, seleccione uno de los métodos siguientes:

»  Numero total de elementos y angulo a rellenar

»  Numero total de elementos y angulo entre elementos

»  Angulo que rellenar y dngulo entre elementos

7. Introduzca el numero de elementos (incluyendo el objeto original) si

esta disponible.

Emplee uno de los siguientes métodos:

» Introduzca el angulo a rellenar y el dangulo entre elementos, si
estan disponibles. El angulo a rellenar es la distancia que hay que
rellenar alrededor de la circunferencia de la matriz. Angulo entre
elementos especifica la distancia entre cada uno de los elementos.

* Haga clic en los botones Precise el angulo a rellenar y Precise el
angulo entre elementos. Utilice el dispositivo senalador para
designar ambos valores.

El cuadro de ejemplo muestra el resultado.

9. Defina cualquiera de las siguientes opciones:

woh o~

N

Sald

So
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» Para girar los objetos segun se organizan en matriz, active ;Girar
objetos a medida que se copian? El drea que aparece como
ejemplo muestra el resultado.

» Para especificar el punto base XY, seleccione Mas, desactive la
opcion Establecer en valor por defecto del objeto e introduzca
valores en los cuadros X e Y, o haga clic en el boton Precise punto
base y designe un punto mediante el dispositivo senialador.

10. Haga clic en Aceptar para crear la matriz.

O  oQp
o> )b
050
matriz polar con objetos  angulo de matriz polar

girados para rellenar=180;
ohjetos no girados

e  Trim: realiza corte de lineas basandose en otras lineas u otros cortes

Para recortar objetos
1. Haga clic en el menu Modificar » Trim.
2. presionar click derecho en cualquier parte de la hoja.

3. selecciona los segmentos que desees recortar (segmentos 1,2,3,4,5).
L)

Command: _trim

ICurrent settings: Projection=UCS, Edge=None

ISelect cutting edges ...

ISelect objects or «<select all»: Specify opposite corner: 1 found
ISelect objects:

ISelect object to trim or shift-select to extend or

[Fence/Crossing/Project/Edge/eRase/Undo] :

[57.1553, 73,7699 , 0.0000 sNAP| [GRID [ORTHO POLAR| [0SNAP OTRACK pucs| oyn| Lwr][mol

Otra forma es:
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e Break at point: esta herramienta permite cortar una linea o arco a una
distancia determinada. Para lograr esta operacion se realiza lo
siguiente:

1. seleccionar break at point
2. seleccionar el objeto
3. seleccionar el punto donde se realizara el corte.

e Break: sirve para quitar parte de un objeto, puede partir: lineas,
circulos, arcos, polilineas, elipses, splines, xlines, rayos.

=

Para partir un objeto

1. seleccionar break

2. seleccionar un objeto para partir.

3. por defecto, el punto que usted seleccione en el objeto sera el primer
punto para partir. Para escoger un punto diferente de rompimiento
ingrese T (primero/first) y especifique el nuevo punto de particion

4. especifique el segundo punto de particion.

e Extend: permite que una linea se extienda hasta chocar con un objeto
de referencia limitante.

1. seleccionar Extend

2. selecciona el objeto de referencia o hasta donde deseamos extender,
presiona Intro.

3. selecciona las lineas a extender y presiona Intro.
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Select objects:

Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo] : Specify opposite corner:
Select cbject to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Unda] :

Select cbject to extend or shift-select to trim or

[Fence/Crossing/Projeet/Edge/Undo] :

151.0019, 166.8972.0.0000 | SNAP|[GRID [0RTHO POLAR) [osnaP OTRACK] DUCS| DY) LWT][MoDEL
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o Fillet (empalme): Un empalme conecta dos objetos mediante un arco
que es tangente a los objetos y tiene un radio determinado.

—

primer objeto
designado

Una esquina interior se denomina empalme y una esquina exterior se denomina
redondeo. Ambas se pueden crear utilizando el comando empalme.

Puede empalmar: arcos, circulos, elipses y arcos elipticos, lineas, polilineas,
Rayos, splines, lineas auxiliares, 3D (solidos).

Para definir el radio del empalme
1. Haga clic en el menu Modificar » Empalme.
2. Escriba ra (Radio).
3. Defina el radio del empalme.
4. Designe los objetos que desee empalmar.

Para empalmar dos segmentos de linea
1. Haga clic en el menu Modificar » Empalme.
2. Designe la primera linea.
3. Designe la segunda linea.

Para empalmar un objeto sin recortarlo
1. Haga clic en el menu Modificar » Empalme.
2. Si fuese necesario, escriba r (Recortar). Escriba d (Desactivar recortar).
3. Designe los objetos que desee empalmar.

e Chamfer: Un chaflan conecta dos objetos con una linea en dngulo.
Normalmente se utiliza para representar un borde biselado en una
esquina.

= 1 24+ =2

primera inea designanda seguade linep desigrads iesultade

Puede achaflanar: lineas, polilineas, Rayos, lineas auxiliares, 3D
(solidos)

Se puede utilizar CHAFLAN para biselar todas las esquinas de una
polilinea mediante un unico comando.
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Para establecer distancias entre chaflanes
Haga clic en el menu Modificar » Chaflan.
Escriba d (Distancia).

Escriba la distancia del primer chaflan.
Escriba la distancia del segundo chaflan.
Designe las lineas que desee achaflanar

SR N~

Para achaflanar dos segmentos de linea no paralelos

1. Haga clic en el menu Modificar » Chaflan.
2. Designe la primera linea.
3. Designe la segunda linea

Para achaflanar precisando la longitud y angulo del chaflan

1. Haga clic en el meni Modificar » Chaflan.
2. Escriba an (Angulo).

3. Escriba la distancia desde la esquina para achaflanar en la primera

linea.
4. Indique angulo del chaflan.

5. Designe la primera linea. A continuacion, seleccione la segunda

linea.

Para achaflanar un objeto sin recortarlo

1. Haga clic en el menu Modificar » Chaflan.
2. Escriba r (Recortar).

3. Escriba d (Desactivar recortar).

4. Designe los objetos que desee achaflanar.

o  Offset: Permite crear un nuevo objeto a una distancia especifica,
basandose en un objeto existente. Esta distancia es relativa al objeto

existente.

1. selecciona Offset, en el menu principal modify o en la barra de

edicion de entidades.

escribe la distancia y enter

selecciona el objeto a extraer un Offset.
hacer clic hacia adentro o fuera del objeto.

SR

desea o sino presionar la tecla ESC.
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[Fommana: _oftaet

furcent acttings: Exase FSETOAP
bpecify offsct distance or [Through/Erase/Layes] <10.00005: 10
Belect object to offsec or [Exic/Ondo] <Exica:

brecity point on side to offset or [Exit/Maltiple/Undo] <Exits:
felect obisce to affmec or (Exic/Onda) chwies:

Ppecify point an side to offses or [Exit/Maltiple/Undo] <Exits:

I 55 9658 0 D0DD GRIO POLAR OYH LWT| [M0BEL

puede repetir puede repetir desde el paso 4 al 5 tantas veces como lo
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Si no se sabe la distancia

1.

2.
3.
4

Offset, luego Intro

Specify offset distance or [Through/Erase/Layer] <Through>: Pl
Specify second point: P2

Select object to offset or [Exit/Undo] <Exit>: {selecione el objeto a
hacer paralela.

Specify point on side to offset or [Exit/Multiple/Undo]
<EXxit>:{seleccionar un punto en donde se desea la paralela.

e  Strech: Puede volver a ubicar los puntos finales de los objetos que se
encuentran a lo largo o dentro de una ventana de designacion de
captura.

>APRYE - aHO 0

Los objetos incluidos parcialmente en una ventana de captura se
alargaran.

Los objetos que no estén totalmente incluidos en una ventana de
captura, o que se designen individualmente, se desplazaran en lugar
de alargarse

ICommand :

Command: _stretch

Select objects to stretch by crossing-window or crossing-polygon...
Select objects: Specify opposite corner: 1 found

Select objects:

Specify base point or [Displacement] <Displacement>:

Specify second point or <use first point as displacement>:

1052665, 71.9814 . 0.0000 | snaP|[GriD [oRTHO POLAR| [osnap OTRACK| DUCS| DYN| LwWT| [MoDEL
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Para estirar un objeto
1. Haga clic en el menu Modificar » Estirar.
2. Designe el objeto utilizando una ventana de captura.
La ventana de captura debe incluir al menos un vértice o punto final.
3. Realice una de las siguientes acciones:

» Indique el desplazamiento en forma de coordenadas cartesianas,
polares, cilindricas o esféricas. No escriba una arroba (@) porque
ya se espera que sean coordenadas relativas. Pulse INTRO en la
solicitud del segundo punto de desplazamiento.

» Precise el punto base para el estiramiento y, a continuacion,
especifique un segundo punto para determinar la distancia y la
direccion.

Cualquier objeto que tenga al menos un vértice o punto final dentro de
la ventana de captura se estirara. Cualquier objeto que se encuentre
totalmente dentro de la ventana de captura, o que se seleccione
individualmente, se desplazara sin estirarse.

iy e rm—

Dirjelnz depnados purins piecisades pRa resilasts
w SR ey

e Explode: divide un objeto compuesto por aquellos objetos que lo
componen, se pueden descomponer en solidos 3D, bloques, cuerpos,
cotas, multilineas, mallas, polilineas y regiones.

Para lograr esta operacion se realiza lo siguiente:
1. seleccionar la herramienta explode
2. seleccionar los objetos a dividir y presione enter.

e Undo: orden que permute deshacer la ultima orden ejecutada. Podemos
deshacer varias ordenes, Autocad lo hace en sentido inverso, es decir, la
ultima ordene ejecutada serd la primera en deshacerse.

1. Puede activarse a traves de la barra de herramientas, tal como se
indica en la figura.

EE, File Edit View Insert Format Tools Draw Dimension Moc

HDﬁEI&D@ﬁI&&I@l:ﬁIJ Y-
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2. Se puede activar escribiendo en la ventana de didlogo la tecla U y
luego enter.

3.3. MATERIALES Y EQUIPOS

e  Modulo AutoCAD
e Programa AutoCAD

3.4. EJERCICIOS RESUELTOS

59

«

P,

4

4.95
8

Observamos en este dibujo se han usado multiples comandos, como también hay
varias maneras de hacerlo o por donde comenzar, a continuacion se detallara

una manera a realizarse:

1. Ingresamos line
e Precisamos un primer punto cualquiera, activamos la funcion ortho,
con el puntero dirigido hacia la derecha colocamos una distancia de
84, luego con el puntero hacia arriba colocamos 59.9, luego con el
puntero hacia la izquierda colocamos 84 y finalmente colocamos c,

para cerrar el rectangulo.
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2. Con los modos de referencia activos (especificamente punto medio), tomamos
el punto P; y lo unimos con el punto P;, nuevamente activamos la orden line,
y unimos los puntos P,y Py.

3. Usamos la orden offset, y colocamos la distancia 23.83, cuando solicita el
lugar en donde se colocara la paralela tanto a la izquierda como a la
derecha, esto para ubicar los centros de los circulos de la izquierda y
derecha. Usamos el mismo comando para ubicar los centros de los circulos
superior e inferior, la distancia a colocar es 13.95.

4. Ubicados los centros, ingresamos a Circle

e Precise punto central para circulo o [3P/2P/Ttr]: en los centros
determinados anteriormente.

e Precise radio de circulo: 10.95.

e Y con estos mismos pasos en los cuatro centros que se indican.

5. Ingresamos offset
e Precise primer la distancia de 4.95.
o Seleccione el eje central vertical.
e Precise el punto donde se colocara la linea paralela a la izquierda y
derecha

6. Usamos trim
e Para recortar los segmentos no deseados.

7. Usamos polygon
e Precise el numero de lados del poligono: 4
e Precise el centro del circulo del lado izquierdo
o Seinale I de inscrito, y el radio del circulo 10.95
e Para el hexagono se dara el numero de lados: 6
e Precise el centro del circulo del lado superior
e Senialamos I de inscrito, y el radio del circulo 8.6

8. Usando Rotate para rotar los poligonos obtenidos un angulo de 90° si es
necesario.

9. Usar offset para hacer el hexdgono paralelo a una distancia de 2.
Nuevamente offset para hacer la cruz.
o Offset a 1.2 a ambos para formar los brazos. Los brazos tienen una
longitud de 6, para lo cual también se usa offset.

10.  Trim para recortar y dar forma a la cruz.

11.  Mirror para reproducir los elementos que se repiten a los extremos
opuestos.

12.  Usar offset para dibujar el circulo mayor al circulo de radio 10.95 a la
distancia de 3.
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13.

14.

15.

16.

17.

Circle para dibujar el circulo de radio 10 tangente externo a los circulos
obtenidos.

Usar trim para recortar los sobrantes y dar la forma deseada.
Offset a la distancia de 2 y dar la forma final.

Offset a la distancia de 3 para formar la cuadricula externa a la figura, se
empieza del centro hacia afuera.

Finalmente trim para recortar los sobrantes.

3.5. EVALUACION

Acera

[ 0.8 ©
Acera A

35

L
.59
T

.4
.85

Acera > ~
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CAPITULO IV
“Textos, Propiedades, Capas y Sombreados”

4.1. OBJETIVOS

Estilo de texto (Text Style)

Textos de lineas simples (Dtext).

Textos de lineas multiples (Mtext).

Propiedades: colores, tipos de lineas y creacion de capas.
Control de propiedades de capas.

Sombreados con hatch.

4.2. EUNDAMENTO TEORICO

Estilo de texto: Los estilos empleados para textos de una linea son los
mismos que los utilizados para textos de lineas multiples. Al crear texto,
puede asignarle un estilo existente o crear un estilo de texto, para definir
nuevos estilos de texto se debe acceder Format>Text Style y se mostrara el
siguiente cuadro de didlogo:

mesve S 020 =
Current text style: Standard
Styles:
- Font G
£ Annotative Fort Name: Font Style:

K S

Use Big Font

Size
Annotative (1)

[] Match text orientation
to layout

Effects
Upside down Width Factor:
1.0000

Backwards
Obligque Angle:

Vertical 0

soply | [ Cancel | [ Hep

Para crear el estilo de texto:
e Enel cuadro de didlogo activar new, dar el nombre, luego Ok
e Aparece en Style el nombre del estilo que se crea ademéas de los
estilos existentes. Puede seleccionar el estilo de texto que desee.
e Delete: borra el estilo seleccionado en la lista. No debe haber ningun
texto creado con ese estilo de los contrario aparecera un error.
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e Escoger el nombre de letra en Font Name. Puede ser SHX (formas
compiladas, a base de vectores) o TTF (fuentes escalables: True Type
Fonts, definidos con toda precision y rellenos).

e Dar el estilo de letra en Font Style, en aquellos tipos de letras que lo
admite, se puede indicar un efecto de negrita o cursiva. Si la casilla:
“Use big Font™, se encuentra activada, la lista especifica el tipo de
archivo de letra grande a utilizan en el estilo. Este debe ser .SHX.

e Dar efectos, tamafio de letra, factor de compresién y angulo de
inclinacion de la letra.

e Hacer click en Apply, y quedara creado el estilo de texto.

Cument tead style: Standard
Styles:
£ Annotative
Standard

Fortt
Font Name:

& bt shx

[ 1Use Big fot

I New Te_\rl Style

Style Name:

1.0000
Backwards
Oblique Angle:

Vertical 0

[ ooy | [ Cancel ] |

Current text style: style1
Styles:
A Annotative
Standard
style1

Fort
Fort Name:

["] Use Big Font

Size
[C] Annotative (1]
[]Match text orientation
to layout

Effects

Upside down Width Factor:
1.0000

Backwards
Oblique Angle:

[ Vertical 0

[ tody ][ Cose ][ Hp |

Texto en una linea (Dtext): Los estilos empleados para textos de una linea
son los mismos que los utilizados para textos de lineas maltiples. Al crear
texto, puede asignarle un estilo existente escribiendo el nombre del estilo que
desee en la solicitud Estilo.
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En la barra estandar, en el icono que se muestra desplegado, puede verse el
estilo de texto creado (style 1), ademés de mostrarse los estilos de texto
existentes por defecto.

s AutoCAD 2008 - [Drawingl.dwg]

E File Edit View Inset Format Tools Draw Di i Medify  Wind Help  Express Tvi
IDRA 2R S «RO s #| £ V- SR BERID B @[ & o .4 1502
[ runcroomee - gi | 700 bmo S w[mat i

ST ~
7

Para crear Texto en una linea simple
e Activar la orden texto en el menu principal Draw>Text>Single line
text.
e En laventana de dialogo se observa el siguiente mensaje:
0 Current text style: “stylel” text height: 2.5 Annotative: No
0 Specify start point of text or [Justify/Style]: P1
0 Specify height <2.50>: {coloque la altura que crea adecuada,
segun el tamafio de letra que desee}.
o Specify rotation angle of text <0>: {coloque el angulo que
desea que se incline el texto, para el ejemplo lo dejamos en 0}
0 Proceda a escribir lo que desee, tantas veces como desee,
pulse enter para cambiar de linea y si desea finalizar la orden
coloque doble enter.

[P REHI&RD |G 4 Moding "R mERIDE
|| mByLayer - Bylay /" Line e -]
[Hy FMI©O PO AIRIEHS L F| s -

" Construction Line
Multiline

—=) Polyline
2, 3D Polyline
 Polygon
[T Rectangle

2= Helix

Arc
Circle
@ Donut
r~ Spline
Ellipse
Block

E Table...
Point

1 Hatch...

l Gradient...

H Boundary...

Region
Wipeout

£ Revision Cloud

>EHPEE - aHIO 0 LOGNTOL NN

2 A Multiline Text...

Single Line Text
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> P M

LI Layout1 4 Layout?

ICommand: dtext

ICurrent text style: "stylel™ Text height: 2.5000 Annotative: HNo
Specify start point of text or [Justify/Style]:

Specify height <2.5000>:

Specify rotation angle of text <0>:

|130.8908, 61.0940.0.0000 | SNAP| GRID| ORTHO| POLAR|[osNAP OTRACK| DUCS| DYN| LWT] [moDEL

Para especificar el estilo al crear texto de una linea

1. Haga clic en el menu Dibujar » Texto » Texto en una linea.

2. Escriba e (Estilo).

3. En la solicitud Nombre de estilo, escriba un nombre de estilo de texto
existente.
Si antes desea ver una lista con los estilos de texto disponibles, escriba? y
pulse INTRO dos veces.

4. Siga creando el texto.

Texto de lineas multiples: Puede crear uno o varios parrafos de texto de
lineas multiples (textoM).

Para crear texto de lineas maltiples

1. Haga clic en el menu Dibujo » Texto » Texto de lineas multiples.

2. Designe las esquinas opuestas del cuadro delimitador para definir la
anchura del objeto de texto de lineas maltiples.

e Designe primera esquina:

Indique la esquina opuesta o [altura / Justificar / Interlineado / Rotation /

Estilo / Grosor]:

M e bdn View Insert Format Took [Daw | Dmersion  Mod

PEHPHE -2 H00LIBNTOLNN

CIEICIC] { Lyous { Layens? |
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Esquina opuesta

A medida que se arrastra el dispositivo sefialador para indicar la esquina
opuesta, un rectangulo mostrara la posicion y el tamafio del objeto de texto de
lineas maltiples. Las flechas del interior del rectangulo indican la direccion
que seguira el texto del parrafo.

-
@
g
~
o
>
w3
)
=2
4
&
A

(Command :

(Command :

(Command: mtext Current text style: "stylel" Text height: 2.5 ZAnnotative:
Mo

Specify first corner:

Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width/Columns]:

[186.7241. 120.2520.0.0000__| 5P| GRID| ORTHO| POLAR [osnaP OTRACK] DUCS| DYN] LT [MoDEL
L. rite * - g "

Posteriormente se accede a un cuadro de didlogo como el que se muestra
donde se puede acceder a una gran cantidad de opciones que se muestran
en los iconos como:

seleccionar el estilo de texto.

El tamafio de la letra.

El tipo de la fuente.

La alineacion, justificacion, interlineado, inclinacién, etc.
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e Altura

= Especifica la altura del texto que se va a utilizar para los
caracteres de texto de lineas multiples.

» Precise altura:
Si la altura por defecto es distinta de cero, se considerara la altura del
estilo actual; de lo contrario, se considerara la altura almacenada en la
variable de sistema TEXTSIZE. La altura de los caracteres se calcula en
unidades de dibujo. Al modificar la altura se actualiza el valor
almacenado en TEXTSIZE.

e Justificar

Determina la justificaciéon y el flujo del texto nuevo o seleccionado, en
relacion con el contorno de texto. La justificacion actual (Superior
izquierda por defecto) se aplica al nuevo texto.

El texto se justifica dentro del rectdngulo designado tomando como base
el tipo de justificacion elegida y uno de los nueve puntos de justificacion
del rectangulo.

= El punto de justificacién se basa en el primer punto utilizado para
designar el rectangulo. El texto se encuentra centrado, justificado a la
izquierda o justificado a la derecha con respecto a los contornos de
texto izquierdo y derecho. Los espacios indicados al final de una linea
se incluyen como parte del texto y afectan a la justificacion de la linea.
El flujo de texto controla si éste se alinea desde el centro, la parte
superior o la parte inferior del parrafo con respecto a los contornos de
texto superior e inferior.

Indique la justificacion [SI/SC/SD/MI/MC/MD/11/IC/ID] < SI>:

S0 {supenor ceatrn) —
iTguenta derechai
M émedio — —_ B ey
irquierda)
Il dimferion ipquienta) — = [ | 2V iR iR
T fmedi comniroh
i A finfenor eenlne)
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2008 - [Drawing2.dwg]

dit  View

Insert Format Tools Draw Dimens
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5=

¥ Top Left

Top Center
Top Right
Middle Left
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. Middle Right
Bottomn Left
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Bottomn Right

Los ejemplos siguientes reflejan las opciones de justificacion.
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alineacian inferior

=
2
=
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& inferior
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==

inferior izquierda:
Jjustif- a la
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alineaciin
SUperion

Interlineado

!
I
!ii

'I
III'
/
]

superior centro:

justif. en el centro,

alineacion inferior

medio centra:

justif. en el centro,

alineacion sup. e
inferior

inferior centro:

justif. en el centro,

alineacion
superion

=SS E T
=S
e
Tt
=
— T
supernor derecha:
justif. a la der_,
alineacion inferior

medio derecha:
jusiif. a la derecha,
alineacion sup. e
inferior
= —
=ceateae
e

g e
e

= i b

RIASSEES
T .

inferior derecha:
justif. a la
derecha,
alineacion
superior

Define el interlineado para los objetos de texto de lineas multiples. El
interlineado es la distancia vertical entre la parte inferior (o linea base)
de una linea de texto y la parte inferior de la siguiente linea de texto.
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Nota.- Cuando se utiliza TEXTOM para crear una tabla, se recomienda el
uso de un interlineado exacto. Para asegurarse de que el texto no queda
solapado, utilice una altura de texto menor que el interlineado
especificado.

Indique el tipo de interlineado [Al menos/Exactamente] <actual>:

v" Al menos
Ajusta autométicamente las lineas de texto en funcion de la altura del
caracter de mayor tamafio de la misma. Cuando se selecciona Al
menos, las lineas de texto con caracteres presentan espacios
adicionales entre lineas.
Indique el factor de interlineado o distancia <actual>:

v Factor de interlineado: Especifica el interlineado como multiplo del
interlineado sencillo.

El interlineado sencillo es 1.66 veces la altura de los caracteres de
texto. El incremento de interlineado se indica como un nudmero
seguido de una x para indicar un multiplo del interlineado sencillo. Si
desea, por ejemplo, interlineado sencillo, escriba 1x y para
interlineado doble, 2x.

v" Distancia: Establece el interlineado en un valor absoluto medido en
unidades de dibujo. Se aceptan valores entre 0.0833 (0.25x) y 1.3333
(4x).

v' Exactamente
Hace que el interlineado sea el mismo para todas las lineas de texto
del objeto de texto de lineas multiples. El interlineado se basa en la
altura del texto del objeto o estilo de texto.
Indique el factor de interlineado o distancia <actual>:

Factor de interlineado: Especifica el interlineado como mdaltiplo del
interlineado sencillo.

El interlineado sencillo es 1.66 veces la altura de los caracteres de
texto. Puede indicar como factor de interlineado un nimero seguido
de una x para indicar un multiplo del interlineado sencillo. Si desea,
por ejemplo, interlineado sencillo, escriba 1x y para interlineado
doble, 2x.

Distancia: Establece el interlineado en un valor absoluto medido en
unidades de dibujo. Se aceptan valores entre 0.0833 (0.25x) y 1.3333
(4x).

e Rotation:

Especifica el angulo de rotacion del contorno de texto.
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Indique el angulo de rotacion <actual>: Designe un punto o escriba un
valor

Si utiliza el dispositivo sefialador para designar un punto, el angulo de
rotacion quedara determinado por el angulo entre el eje X y la linea
definida por el Gltimo punto introducido (el valor por defecto es 0, 0,0) y
el punto designado.

La solicitud anterior se volvera a mostrar hasta que se precise la esquina
opuesta del contorno de texto.

e Estilo
Especifica la altura del texto que se va a utilizar para el texto de lineas
multiples.
Indique el nombre del estilo o [?] <actual>:

v Nombre de estilo
Especifica un nombre de estilo de texto. Los estilos de texto se
pueden definir y guardar mediante el comando STYLE.

v’ Lista de estilos
Muestra los nombres de estilo y caracteristicas de texto.
La solicitud anterior se volvera a mostrar hasta que se precise la
esquina opuesta del contorno de texto.

e Grosor
v' Especifica la anchura del contorno del texto.
v" Indique la anchura Designe un punto o escriba un valor

Si utiliza el dispositivo sefialador para designar un punto, la anchura se
calcula como la distancia entre el punto inicial y el punto designado. Las
palabras dentro de cada linea del objeto de texto de lineas multiples se
ajustaran automaticamente para ocupar la anchura del contorno de texto.

Si la anchura especificada es 0, se desactivara el ajuste automético de
linea y la anchura del objeto de texto de lineas multiples tendra la misma
extension que la linea mas larga del texto. Para finalizar una linea de
texto en un punto determinado, escriba el texto y pulse INTRO. Para
finalizar la ejecucién del comando, pulse INTRO en la solicitud de
TEXTOM.
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Capas: Las capas se utilizan para agrupar informacion de un dibujo segun la
su funcién y para reforzar los tipos de linea, el color y otros parametros.

rawingl.dwg]

|;E, File Edit View Inset Format Tools Draw Di i Modify Express Window Help Type a question for help
DHEeRRE|=%RO s #|£-) |SRARBAEARIYM|@ || 2octratiranon - 1 |
= -] bow | —biaw - |[5ex | [$[00®m0 "mew|
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T E® | & L

Layer Properties Manager

AT AutoCAD 2008 - [DrawingLdwg]

f™ File Edit View Insert [Format| Tools Draw Dimension Modify

Y- EY ¢ &

AutoCAD Classic

% Layer States Manager...
Layer tools 4
Color...

Linetype...
Lineweight...
Scale List...

B Text Style...

,,4 Dimension Style...

& Table Style...

B4 Multileader Style
Flot Style...
Boint Style...
Multiline Style...

Units...
s# Thickness
Drawing Limits

Rename...

B - aHI 01O I O LN\

Las capas son equivalentes a las hojas transparentes que se utilizan en el
disefio sobre papel. Las capas son la herramienta organizativa principal
empleada en el dibujo. Las capas se utilizan para agrupar informacién por
funcion y para imponer el tipo de linea, el color y otras normas

Para crear una nueva capa

Crea una capa nueva. La lista muestra una capa denominada CAPAL. El
nombre aparece seleccionado, de manera que se puede especificar un nuevo
nombre de capa inmediatamente. La nueva capa hereda las propiedades de la
capa seleccionada actualmente en la lista de capas (color, estado activado o
desactivado, etc.).

1. Haga clic en el mend Format » Layer.
2. En el Administrador de propiedades de capas haga clic en el botén New
Layer.
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Se afadira automaticamente un nombre de capa, como Layerl, a la lista
de capas.

Escriba un nombre de capa nuevo sobre el nombre de capa resaltado.

El nombre de capa puede incluir hasta 255 caracteres: letras, digitos y los
caracteres especiales de simbolo de dolar ($), guion (-) y subrayado ().
Utilice el simbolo (*) delante de otros caracteres especiales, para que
éstos no se interpreten como caracteres comodin. Los nombres de capa no
pueden incluir espacios en blanco.

Para cambiar las propiedades, haga clic en los iconos.

Al hacer clic en Color, Tipo linea, Grosor de linea o Estilo de trazado,
aparece un cuadro de diélogo.

(Opcional) Haga clic en la columna Descripcion e introduzca un texto.
Haga clic en Aplicar para guardar los cambios o en Aceptar para guardar
y cerrar

% @ X« Curentlayer: 0

L.. Color Linetype Lineweight Plet St... P.. N.. Description
[0 1% @ & [Owh. Contruous — Defz s W

iosite corner:
s

Search for layer <
Al: 1 layers displayed of 1 total layers
Invert filter Indicate layers in use

2l Layer Properties Manager

£8 ¥ ()4 X « Curentlayer0

=% A Hame
i All Used Layers Mew Layer (Alt+M)

0. Fe Color  Linetype  Linewsight PlotSt.. P N. Description
Ty [ wh.. Continuous —— Defa... ]

Search for layer

All: 1 layers displayed of 1 total layers
[ Invert fitter [ Indicate layers in use
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=4 i
- Al Used Layers ; My M wh.. Contiuous — Defa.. Color_7
- % [ wh.. Continuous — Defa.

Search for layer

All: 2layers displayed of 2total layers
[ Invert fitter [ Indicate layers in use

Propiedades de capas:

Muestra una lista de las capas existentes en el dibujo junto con sus
propiedades. Puede afadir, suprimir y renombrar capas, modificar sus
propiedades o afiadir descripciones. Los filtros de capas controlan las capas
que se incluyen en la lista y permiten, ademas, realizar cambios en varias
capas a la vez.

El Administrador de propiedades de capas consta de dos paneles:
Vista en arbol y Vista de lista.

1] )08 - [Drawingl.dwg]
™ File Edit View Inset Format Tools Draw Dimension Modify Window Help Express Type a question for help
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Vista en arbol:

Muestra una lista jerarquica de las capas y los filtros del dibujo. ElI nodo
superior, Todas, muestra todas las capas del dibujo. Los filtros aparecen en
orden alfabético. El filtro Todas las capas usadas es de sélo lectura.

Expanda un nodo para ver los filtros anidados. Haga doble clic en un filtro de
propiedades para abrir el cuadro de didlogo Propiedades de filtro de capas y
ver la definicion del filtro.

= Menu contextual de la vista en arbol
Proporciona comandos para los elementos seleccionados en la vista
en arbol.

» Visibilidad
Cambia el estado de visibilidad de todas las capas del filtro
seleccionado (0 de Todas o Todas las capas usadas, si se han
seleccionado).

- Act: Los objetos de la capa se muestran, trazan y regeneran,
ademas de ocultar a otros objetos cuando se usa OCULTA.

— Des: Los objetos de la capa no se muestran ni se trazan, pero
ocultan a otros objetos cuando se usa OCULTA. El dibujo no se
regenera al activar la capa.

- Reutilizada: Los objetos de la capa se muestran y trazan, ademas
de ocultar a otros objetos cuando se usa OCULTA.

- Inutilizada: Los objetos de la capa no se muestran ni se trazan,
pero ocultan a otros objetos cuando se usa OCULTA. El dibujo se
regenera cuando se reutiliza la capa.

= Bloquear

Controla si los objetos situados en las capas del filtro seleccionado se

pueden modificar.

- Bloquear: Ninguno de los objetos de la capa se puede modificar.
Sin embargo, se pueden aplicar referencias a los objetos de una
capa bloqueada y realizar otras operaciones que no modifiquen
es0s objetos.

— Desbloguear: Los objetos de la capa se pueden modificar.

* Ventana
En la ventana de la presentacion actual, controla el ajuste de
inutilizacion en ventana de las capas del filtro de capas seleccionado.
Esta opcion no se encuentra disponible para las ventanas del espacio
modelo.
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Inutilizar: Establece Inutilizar en la ventana actual para las capas
del filtro. En la ventana gréafica actual, los objetos de la capa no se
muestran ni se trazan, pero ocultan otros objetos cuando se usa
OCULTA. El dibujo se regenera cuando se reutiliza la capa.

Reutilizar: Anula Inutilizar en la ventana actual para las capas del
filtro. En la ventana actual, los objetos de la capa se muestran y se
trazan, y ocultan otros objetos cuando se usa OCULTA. Esta
opcion no reutiliza las capas que se han definido como
desactivadas o inutilizadas en el dibujo.

Aislar grupo
Desactiva todas las capas que no estan incluidas en el filtro
seleccionado. Las capas visibles son las capas del filtro.

Todas las ventanas: En todas las ventanas graficas de una
presentacion, establece Inutilizar en la ventana actual para todas
las capas que no forman parte del filtro seleccionado. En el
espacio modelo, desactiva todas las capas que no se encuentran en
el filtro seleccionado.

S6lo ventana activa: En la ventana gréafica de la presentacion
actual, establece Inutilizar en la ventana actual para todas las
capas que no forman parte del filtro seleccionado. En el espacio
modelo, desactiva todas las capas que no se encuentran en el filtro
seleccionado.

Nuevo filtro de propiedades

Muestra el cuadro de didlogo Propiedades de filtro de capas, que
permite crear un filtro de capas basado en una o varias propiedades
de las capas.

Nuevo filtro de grupo

Crea un filtro de capas que contiene las capas que se seleccionan y
afaden al filtro.

E% & L@ X ¢ Curentbyerd

= 2 5. N 0. F L. Col Li L ht  Plot St P N. Descr
New Property Filter (Alt+P) == = 2 _ - = - hchps oo ey bk
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Search for layer <

‘AL 1 layers displayed of 1totallayers
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o
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Settings.

= Nuevo filtro de propiedades
Muestra el cuadro de didlogo Propiedades de filtro de capas, que
permite crear un nuevo filtro de capas basado en los nombres y los
ajustes de las capas, como los estados activada o desactivada, el color
o el tipo de linea.

= Nuevo filtro de grupo

Crea un nuevo filtro de grupos de capas denominado FILTRO DE
GRUPOL vy lo afiade a la vista en arbol. Escriba un nombre nuevo.
Seleccione el filtro Todas o cualquier otro filtro de capas en la vista en
arbol para visualizar las capas incluidas en la vista de lista y, a
continuacion, arrastre las capas de la vista de lista al nuevo filtro de
grupos de capas de la vista en arbol.

Puede utilizar los métodos de seleccion estandar. Mantenga pulsada la
tecla CTRL para seleccionar mas de un nombre de capa. Mantenga
pulsada la tecla MAYUS y seleccione el primer y el tltimo nombre de
capa de una secuencia para seleccionar todas las capas incluidas en
ella.

= Convertir en filtro de grupo
Convierte el filtro de propiedades de capas seleccionado en un filtro
de grupos de capas. La modificacion de las propiedades de las capas
de un filtro de grupos de capas no tiene efecto sobre el filtro.

=  Renombrar
Cambia el nombre del filtro seleccionado. Escriba un nombre nuevo.

= Suprimir
Suprime el filtro de capas seleccionado. No se pueden suprimir los
filtros Todas, Todas las capas usadas. Esta opcion suprime el filtro de
capas, pero no las capas del filtro.
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Propiedades

Muestra el cuadro de didlogo Propiedades de filtro de capas, que
permite modificar la definicion del filtro de propiedades de capas
seleccionadas. Esta opcion solo se encuentra disponible si se ha
seleccionado un filtro de propiedades de capas.

Seleccionar capas

Cierra temporalmente el cuadro de dialogo Propiedades de filtro de
capas para que se puedan designar objetos en el dibujo. Esta opcién
solo se encuentra disponible si se ha seleccionado un filtro de grupos
de capas.

— Afadir: Anade las capas de los objetos designados al filtro de
grupo de capas seleccionado en la vista en arbol.

— Reemplazar: Reemplaza las capas del filtro de grupo de capas
seleccionado por las capas de los objetos designados en el dibujo.

Administrador de estado de capas

Muestra el Administrador de estado de capas, que permite guardar
los ajustes actuales de las propiedades de las capas de un estado de
capa guardado y restaurarlos mas tarde.
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=  Suprimir capa
Marca las capas seleccionadas para la supresion. Las capas se
suprimen al hacer clic en Aplicar o Aceptar.
Sélo se pueden suprimir las capas sin referencia. Entre las capas a las
que se hace referencia se encuentran las capas 0 y DEFPOINTS, las
capas con objetos (incluidos objetos de definiciones de bloques), la
capa actual y las capas dependientes de referencias externas.

También se consideran referenciadas las capas de un dibujo
parcialmente abierto y no pueden suprimirse.

Nota Tenga cuidado al suprimir capas si esta trabajando en un dibujo
que forme parte de un proyecto conjunto o se base en un conjunto de
normas por capas.

= Definir actual
Establece la capa designada como la actual. Los objetos creados se
dibujan en la capa actual.

= Capa actual
Muestra el nombre de la capa actual.

= Buscar capa
Filtra la lista de capas por nombre rapidamente a medida que se
introducen los caracteres. Este filtro no se guarda al cerrar el
Administrador de propiedades de capas.

» Linea de estado
Muestra el nombre del filtro actual, el nimero de capas que se
muestran en la vista de lista y el nimero de capas del dibujo.

= Invertir filtro
Muestra todas las capas que no cumplen los criterios del filtro de
propiedades de capas seleccionado.

= Indicar capas en uso
Muestra iconos en la vista de lista para indicar si las capas estan en
uso. En un dibujo con muchas capas, desactive esta opcion para
mejorar el rendimiento.

= Aplicar a la barra de herramientas Capas
Controla la visualizacién de las capas en la lista de capas de la barra
de herramientas Capas mediante la aplicacion del filtro de capas
actual.

= Aplicar
Aplica los cambios realizados en las capas y en los filtros pero no
cierra el cuadro de dialogo.
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Vista de lista:

Muestra las capas y los filtros de capas junto con sus propiedades y
descripciones. Si se selecciona un filtro de capas en la vista en arbol, la vista
de lista s6lo muestra las capas de ese filtro de capas.

El filtro Todas de la vista en arbol muestra todas las capas y todos los filtros
de capas del dibujo.

Cuando se selecciona un filtro de propiedades de capas y no hay ninguna
capa que se ajuste a su definicion, la vista de lista aparece vacia. Puede
utilizar los métodos de seleccion estandar del teclado. Para modificar una
propiedad de una capa designada o de todas las capas de un filtro
seleccionado, haga clic en el icono correspondiente a esa propiedad. Cuando
un filtro de capas presenta un icono combinado o la descripcién “Varios”, la
propiedad no es igual en todas las capas del filtro.

S8 B i 4 X« Cumentlayer 0

E-3E Al S. Name &« O. Fe. L. Color Linetype

0 Q9
ol el ® @ 5 O wh. Continuous — Defa..

Loxd All Used Layers

Search for layer

All: 2 layers displayed of 2total layers

Invert filter Indicate layers in use

= Estado
Indica el tipo de elemento: filtro de capa, capa en uso, capa vacia o
capa actual.

= Nombre

Muestra el nombre de la capa o el filtro. Pulse F2 para escribir un
nuevo nombre.

= Act
Activa o desactiva capas seleccionadas. Si una capa esta activada,
esta visible y disponible para su impresién. Cuando una capa esta
desactivada, no esta visible ni tampoco disponible para su impresion,
incluso aunque Imprimir esté activado.

= Inutilizar
Inutiliza las capas designadas en todas las ventanas. Las capas se
pueden inutilizar para acelerar operaciones como las de los comandos

AutoCAD — INGENIERIACIVIL -19-



LABORATORIO DE AutoCAD DAII - UNP

ZOOM, ENCUADRE y muchas otras, mejorar el rendimiento de la

seleccién de objetos y reducir el tiempo de regeneracion para dibujos

complejos. Los objetos de capas inutilizadas no se visualizan, trazan,
ocultan, modelizan ni regeneran.

— Inutilice las capas que desee mantener ocultas durante largos
periodos de tiempo.

— Si tiene previsto cambiar la configuracion de visibilidad con
frecuencia, utilice el ajuste Act/Des para evitar que se regenere el
dibujo.

— Pueden inutilizarse capas en todas las ventanas gréficas, en la
ventana gréafica actual de la presentacion o en ventanas nuevas, a
medida que se crean.

= Bloquear
Bloquea y desbloquea las capas seleccionadas. Los objetos de una
capa bloqueada no se pueden modificar.

= Color
Cambia el color asociado a las capas designadas. Al pulsar el nombre
del color se muestra el cuadro de dialogo Seleccionar color.
Define los valores de color mediante los 255 colores del indice de
colores de AutoCAD.

Paletas de Indice de colores de AutoCAD

— Especifica un color de entre los del indice de colores de AutoCAD.
Si se mantiene el cursor sobre un color, el namero del color y sus
valores rojo, verde y azul apareceran bajo la paleta. Haga clic en
un color para seleccionarlo o introduzca su ndmero o su nombre
en el cuadro Color.

— La paleta grande muestra los colores del 10 al 249.

— La segunda paleta muestra los colores del 1 al 9; estos colores
tienen nombre y nimero.

— Latercera paleta muestra los colores del 250 al 255; son los tonos
de gris

* Tipo de linea
Cambia el tipo de linea asociado a las capas designadas. Al hacer clic
en un nombre de tipo de linea, se muestra el cuadro de dialogo
Seleccionar tipo de linea.
Muestra los tipos de linea disponibles en el dibujo actual.
— Tipos de linea cargados
Muestra la lista de los tipos de linea cargados en el dibujo actual.
— Cargar
Muestra el cuadro de didlogo Cargar o volver a cargar tipos de
linea, que permite cargar los tipos de linea seleccionados en el
dibujo y afiadirlos a la lista de tipos de linea.
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Grosor de linea
Cambia el grosor de linea asociado a las capas designadas. Al hacer
clic en un nombre de grosor de linea, se muestra el cuadro de dialogo
Grosor de linea.

= Estilo de trazado
Cambia el estilo de trazado asociado a las capas designadas. Si se
esta trabajando con estilos de trazado dependientes del color (la
variable de sistema PSTYLEPOLICY esta establecida en 1), no se
puede cambiar el estilo de trazado asociado a una capa. Al hacer clic
en un estilo de trazado, se muestra el cuadro de dialogo Seleccionar
estilo de trazado.

= Imprimir
Controla si se imprimen o no las capas designadas. Al desactivarse la
opcién de impresién de una capa, los objetos de dicha capa siguen
mostrandose. Las capas desactivadas o inutilizadas no se imprimen,
sea cual sea el ajuste de impresion.

» |nutilizar en la ventana actual (disponible s6lo en una ficha de
presentacion)
Inutiliza las capas designadas en la ventana grafica de presentacion
actual. Puede inutilizar o reutilizar las capas de la ventana gréfica
actual sin que esto afecte a la visibilidad de las capas de otras
ventanas graficas.
Inutilizar en la ventana actual reemplaza el valor de Reutilizar en el
dibujo. Es decir, puede inutilizar una capa en la ventana gréafica
actual si esta reutilizada en el dibujo, pero no puede hacerlo si esta
inutilizada o desactivada en el dibujo. Una capa no esta visible
cuando se ha definido como desactivada o inutilizada en el dibujo.

» [Inutilizar en las ventanas nuevas (disponible sélo en una ficha de
presentacion)
Inutiliza las capas designadas en las nuevas ventanas de presentacion.
Por ejemplo, al inutilizar la capa COTAS de todas las ventanas
gréaficas nuevas, se restringe la visualizacion de las cotas de esa capa
en todas las ventanas de presentacion nuevas, pero sin que se vea
afectada la capa COTAS de las ventanas gréficas existentes. A partir
de este momento, siempre que cree una ventana grafica que precise
cotas, podra reemplazar el ajuste establecido por defecto cambiando
el valor de la ventana gréfica actual.

= Descripcion
(Opcional) Describe la capa o el filtro de capas.
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Menu contextual de la vista de lista
Proporciona opciones para modificar la lista, las capas y los filtros de capas
que se han seleccionado.
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» Maximizar columna
Cambia la anchura de la columna para maximizar la visualizacion de
su contenido. Esta opcion esta disponible en el menu contextual que
aparece al hacer clic con el boton derecho en el encabezamiento de
una columna.

= Maximizar todas las columnas
Cambia la anchura de todas las columnas para maximizar la
visualizacion del contenido correspondiente. Esta opcion esta
disponible en el menl contextual que aparece al hacer clic con el
boton derecho en el encabezamiento de una columna.

= Mostrar arbol de filtros
Muestra la vista en arbol. Desactive esta opcion para ocultar la vista
en arbol.

= Mostrar filtros en lista de capas
Muestra los filtros al principio de la vista de lista. Los filtros aparecen
en orden alfabético. Elimine la marca de verificacién para visualizar
Unicamente las capas en la vista de lista.

= Definir actual
Establece la capa designada como la actual.
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= Nueva capa
Crea una capa nueva. La lista muestra una capa denominada CAPAL.
El nombre de esta capa se puede editar inmediatamente. La nueva
capa hereda las propiedades de la capa seleccionada actualmente en
la lista de capas (color, estado activado o desactivado, etc.).

= Suprimir capa

Suprime las capas designadas desde la definicién del archivo de
dibujo. Solo se pueden suprimir las capas sin referencia. Entre las
capas a las que se hace referencia se encuentran las capas 0 y
DEFPOINTS, las capas con objetos (incluidos objetos de definiciones
de bloques), la capa actual y las capas dependientes de referencias
externas.

Nota Tenga cuidado al suprimir capas si esta trabajando en un dibujo
que forme parte de un proyecto conjunto o se base en un conjunto de
normas por capas.

= Cambiar descripcion
Afiade una descripcion o cambia el texto de la descripcion de la capa
o el filtro que se ha seleccionado. La descripcion de un filtro se afiade
al filtro y a todas las capas de éste.

= Eliminar del filtro de grupo
Elimina las capas seleccionadas del filtro de capas de grupo
seleccionado en la vista en arbol.

= Seleccionar Todo
Selecciona todos los elementos mostrados en la vista de lista.

= Borrar todo
Anula la seleccion de todos los elementos en la vista de lista, excepto
la capa o el filtro que se ha seleccionado mas recientemente.

= Seleccionar todas menos actual
Selecciona todos los elementos mostrados en la vista de lista, excepto
la capa actual.

= Invertir seleccion
Selecciona todos los elementos mostrados en la vista de lista, excepto
los que estan seleccionados actualmente.

= Invertir filtro de capas
Muestra todas las capas que no cumplen los criterios del filtro de
propiedades de capas seleccionado.

= Filtros de capas
Muestra una lista de filtros de capas, incluidos Todas y Todas las
capas usadas. Haga clic en un filtro para aplicarlo a la vista de lista.
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= Guardar estados de capa
Muestra el cuadro de didlogo Nuevo estado de capa para guardar,
gue permite guardar el estado de capa y los ajustes de las propiedades
de todas las capas de un dibujo.

= Restablecer estado de capa
Muestra el Administrador de estado de capas, que permite seleccionar
un estado de capa guardado para restaurar los ajustes de todas las
capas del dibujo. Restablece Unicamente aquellos ajustes de
propiedades y de estado de capa que estaban seleccionados al guardar
el estado de la capa.

Hatch: Puede sombrear un area mediante un patron de sombreado predefinido,
definir un patron de linea simple con el tipo de linea actual o crear patrones de
sombreado mas complejos. Uno de los tipos de patréon se denomina sélido y
rellena un area con un color s6lido. También puede crear un relleno de
degradado.

Para sombrear los objetos designados

1. Ingrese hatch
En el cuadro de dialogo hatch - gradient, haga clic en Afadir:
Seleccionar objetos.

2. Designe los objetos que desee sombrear.
No es preciso que los objetos formen un contorno cerrado. También puede
designar cualquier isla que deba quedar sin sombreado.

3. En Ordenar objetos, haga clic en una de las opciones.
El orden de objetos del sombreado se puede cambiar, de forma que el
sombreado se dibuje delante o detras del contorno, o bien delante o detras
de todos los demas objetos.

4. Haga clic en Aceptar.

= / A todesk

el objeto de texto objeto de texto
seleccionado no &5 incluido en el
parte del conjunto conjunto de
de contomos contormos
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Para crear areas de sombreado

1.
2.

7.

ingrese hatch
En el cuadro de dialogo hatch - gradient, haga clic en Afadir: Designar
puntos.

En el dibujo, precise un punto dentro de cada area que desee sombrear y,
a continuacion, pulse INTRO.
Este punto se conoce como el punto interno.

En el cuadro de dialogo hatch - gradient, dentro de la ficha Sombreado,
en el cuadro Muestra, compruebe que el patrén modelo es el patrén que
desea utilizar.

Para cambiar el patron, designe otro distinto en la lista Patron.

Para ver el aspecto del patron de sombreado, haga clic en el boton [...]
junto a Patrén. Haga clic en Aceptar cuando haya terminado con la vista
preliminar.

En el cuadro de didlogo Sombreado y degradado, realice los ajustes que
estime necesarios.

Puede especificar nuevos contornos de sombreado haciendo clic en
Afadir contornos o Eliminar contornos.

En Ordenar objetos, haga clic en una de las opciones.

El orden de objetos del sombreado se puede cambiar, de forma que el
sombreado se dibuje delante o detras del contorno, o bien delante o detras
de todos los demas objetos.

Haga clic en Aceptar.

4.3. MATERIALES Y EQUIPOS

Modulo AutoCAD
Programa AutoCAD
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4.4, EJERCICIOS RESUELTOS
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1. Las unidades a trabajar es el sistema métrico

2. Usamos rectangle

SEGUNDO NIVEL
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e Precisamos un primer punto inicial (0,0) del rectangulo, luego
especificamos la esquina opuesta (14.5, 18.5), con ello elaboramos
el area conde se va a dibujar el plano.

3. Usando line, empezamos a dibujar partiendo de la coordenada (2.4, 15.4),
con la ayuda de dibujo ortho, trazamos una linea vertical de 9.55, luego
horizontalmente de 9.35, hasta tener un rectangulo que representa el area del
terreno.

4. Usamos la orden offset, y colocamos la distancia 0.15 que es el ancho de
pared para representar de esta manera los muros, cuando solicita el lugar en
donde se colocara la paralela debe sefialarse en la parte interna del
rectdngulo que representa el &rea del terreno tanto del lado izquierdo, lado
derecho y el lado posterior, el lado que representa la parte frontal de la casa
no lleva muro por lo que no se ejecuta la orden para éste lado.

5. Ubicados en los cuatro extremos un cuadrado de 0.25 x 0.25, que
representan las columnas, esto puede ser dibujando un primer cuadrado y
después se copia en cada uno de los extremos que se requiere.

e Existen otras columnas de 0.25 x 0.40 en los lugares que se indican.
Deben colocarse a las distancias indicadas.

e Terminamos de construir cada uno de los muros internos del plano a
representar.

6. Terminada la distribucién de toda el area tal como se indica para ello se
hace uso de las 6rdenes linea, trim, offset, copy y move, etc.

7. Procedemos a dar las propiedades a cada una de las entidades dibujadas
colocandolas en sus respectivas capas.

e Para ello acedemos al administrador de capas y creamos las capas:
columnas, cotas, escaleras, muros, repreventanas, ventanas,
sombreados, ademas de la capa 0y defpoints.

e A cada capa se le asigna un color, por ejemplo a columnas —
magenta, cotas — meldn, escaleras — amarillo, muros - rojo,
repreventanas — cian, ventanas — verde, sombreados — gris, 0 — el
color por defecto (negro) y del mismo modo defpoints —negro.

e Asignamos cada uno de las entidades a las capas respectivas. Para
ello pinzamos en la entidad a trasladar luego en la barra de
propiedades de objeto seleccionamos la capa en la que se desea
colocar la entidad. Este procedimiento se repite hasta ubicar cada
objeto en la capa correspondiente.

8. Usamos Text se elabora los textos, para ello primero debe:

e Activar la orden Text

e Sefalar el espacio donde se insertara el texto

e En la ventana de formato de texto se escoge el tipo de letra comic
sans MS

e Laalturade laletraes: 0.12

e Se pueden activar algunas caracteristicas especiales como negrita,
cursiva, color, etc. Esto es para los textos de mayor tamafio.

e Luego se procede a escribir el texto que se desea, luego se acepta y
el texto se fija en el lugar indicado.
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e El mismo procedimiento para cada uno de los textos existentes.
9. Los muebles, puertas y ventanas se pueden dibujar o insertar como bloques.

10. Usar hatch para hacer el sombreado de la cocina y bafio, el estilo de
sombreado es net variando el angulo de inclinacién, para la cocina se usa
un angulo de 45°.

11. Finalmente asignamos tipos de lineas que se necesitan, en la barra de
propiedades activamos y cargamos el tipo de linea que deseamos, Yy
asignamos a donde corresponde.
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4.5. EJERCICIOS PROPUESTOS
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CAPITULO V

“Dimensionado”
5.1. OBJETIVOS

e Elementos de acotaciéon
e Creacion de cotas
e Creacion y edicion de acotados

5.2. FEUNDAMENTO TEORICO
La acotacion es el proceso por medio del cual se afiaden anotaciones de
medida a un dibujo.
Puede crear cotas para una gran variedad de tipos de objeto en muchas
orientaciones. Los tipos basicos de cotas son:

e Lineal
o Radial (radio y diametro)
e Angular

o Coordenada

e Longitud de arco

Las cotas lineales pueden ser horizontales, verticales, alineadas, giradas, de
linea base o continuas (en cadena). En la ilustracion se muestran algunos

ejemplos.
aagda — - lineal Bazontal
| 200
rsad . £V
' [ 3
r-,';“ﬁ“ didmawo o
&
Eneall westical I 1
& &
1 I
TS & e 3O
| L i berse
i EonEuE

Nota Para simplificar la organizacion de los dibujos y la atribucion de escala
de las cotas, se recomienda crear cotas en presentaciones en lugar del
espacio modelo.

Partes de una cota:
A continuacién se enumeran las partes de las que consta una cota junto con
una descripcion.
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Las cotas tienen diversos elementos: texto de cota, lineas de cota, extremos
de cota y lineas de referencia.

LA (O S
incadecola |

exiremt de cols

_rL—H'Iﬁ-HEHH

EBARRA DE
REFUERZG
-l 2 G

El texto de cota es una cadena de texto que normalmente indica el valor de la
medicion, aunque puede incluir, ademas, prefijos, sufijos y tolerancias.

Una linea de cota indica la direccion y la extension de una cota. En las cotas
angulares, la linea de cota es un arco.

Los extremos de cota, también llamados simbolos de terminacion, se
muestran en cada extremo de la linea de cota. Es posible precisar diferentes
tamafios y formas para los extremos o0 extremidades de cota.

Las lineas de referencia, también llamadas lineas de proyeccién o de
referencia, se extienden desde la caracteristica a la linea de cota.

Una marca de centro es una pequefia cruz que indica el centro de un circulo
0 de un arco.

Las lineas de centro son lineas discontinuas que indican el centro de un
circulo o de un arco.

Iineas da ceniro

-k“‘—m de cenlro
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Para crear una cota

1. Cree una capa designada para las cotas y establézcala como capa actual.
2. Cerca de la esquina inferior izquierda de la aplicacion, haga clic en una
ficha de presentacion.

Haga clic en el menu Acotar y seleccione un comando de cota.

Siga las solicitudes de comando.

sw
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Para crear una cota horizontal o vertical

1. Haga clic en el menu Acotar » Lineal.

2. Pulse INTRO para designar el objeto que desee acotar o especifique los
origenes de la primera y segunda linea de referencia.

3. Antes de establecer el emplazamiento de la linea de cota, se puede ignorar
la direccidn de la cota y modificar el texto, el angulo del texto o el angulo
de la linea de cota.

= Para girar las lineas de referencia, escriba g (Girar). A
continuacion, escriba el &ngulo de la linea de cota.
= Para editar el texto, escriba m (texto de lineas maltiples). En el
editor de texto in situ, revise el texto. Haga clic en Aceptar.
Si edita el texto dentro de los corchetes (<>) o los sobrescribe, se cambia
o se elimina el valor de la cota calculada por el programa. Si afiade texto
antes o después de los corchetes, éste se agregara antes o después del
valor de la cota.
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» Para girar el texto, escriba a (Angulo). A continuacion, escriba el
angulo del texto.
4. Designe el emplazamiento de la linea de cota
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Para crear cotas alineadas

1. Haga clic en el menu Acotar » Alineada.

2. Pulse INTRO para designar el objeto que desee acotar o especifique los
origenes de la primera y segunda linea de referencia.

3. Antes de precisar la ubicacion de linea de cota, se puede editar el texto o
cambiar el &ngulo del texto. Si edita el texto dentro de los corchetes (<>)
o0 los sobrescribe, se cambia o se elimina el valor de la cota calculada por
el programa. Si afiade texto antes o después de los corchetes, éste se
agregara antes o después del valor de la cota.
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— Para editar el texto mediante texto de lineas maltiples, escriba m
(texto de lineas multiples). En el editor de texto in situ, revise el
texto. Haga clic en Aceptar.

— Para editar el texto mediante texto en una linea, escriba t (texto).
Revise el texto de la linea de comandos y pulse INTRO.

— Para girar el texto, escriba a (Angulo). A continuacion, escriba el
angulo del texto.

4. Designe el emplazamiento de la linea de cota.

& &
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Para crear una cota de radio
1. Haga clic en el menu Acotar » Radio.
2. Designe un segmento de arco de polilinea, un circulo o un arco.
3. Introduzca las opciones segun sea necesario:
— Para editar el contenido del texto de cota, escriba t (texto) o m
(texto de lineas multiples). Si edita el texto dentro de los corchetes
(<>) o los sobrescribe, se cambia o se elimina el valor de la cota.
Si afiade texto antes o después de los corchetes, éste se agregara
antes o después del valor de la cota.
— Para editar el angulo de texto de cota, escriba a (angUlo).
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4. Designe el emplazamiento de la linea directriz.
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Para crear una cota de didmetro
1. Haga clic en el menu Acotar » Didmetro.

2. Designe el arco o el circulo que desea acotar.
3. Introduzca las opciones segln sea necesario:
Para editar el contenido del texto de cota, escriba t (texto) o m
(texto de lineas multiples). Si edita el texto dentro de los corchetes
(<>) o los sobrescribe, se cambia o se elimina el valor de la cota.
Si afiade texto antes o después de los corchetes, éste se agregara

antes o después del valor de la

= Linear

%, Aligned
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;ﬁ Ordinate
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E Dimension Space
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& Dimension Style...
®# Override
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Reassociate Dimensions

cota.

Para cambiar el angulo de texto de cota, escriba a (d&ngUlo).
4. Designe el emplazamiento de la linea directriz
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@0 545 #0.545
Para crear una cota angular
1. Haga clic en el menu Acotar » Angular.
2. Emplee uno de los siguientes métodos:

Para acotar un circulo, designe éste en el primer punto final del
angulo y, a continuacion, precise el segundo punto final del
angulo.

Para acotar cualquier otro objeto, designe la primera linea y luego la
segunda.

3. Introduzca las opciones segln sea necesario:
Para editar el contenido del texto de cota, escriba t (texto) o m (texto
de lineas multiples). Si edita el texto dentro de los corchetes (<>)
0 los sobrescribe, se cambia o se elimina el valor de la cota
calculado. Si afiade texto antes o después de los corchetes, éste se
agregara antes o después del valor de la cota.
Para editar el angulo de texto de cota, escriba a (angUlo).
4. Designe el emplazamiento del arco de linea de cota.

Para crear cotas de linea base

1. Haga clic en el menu Acotar » Linea base.

Por defecto, el origen de la Gltima cota lineal creada se utiliza como primera
linea de referencia para la nueva cota de linea base. Se le solicitara que
especifique la segunda linea de cota.

2. Utilice una referencia a objeto para designar el origen de la segunda
linea de referencia, o pulse INTRO para designar cualquier cota como
cota base.

El programa coloca de forma automatica la segunda linea de cota a la distancia
determinada por la opcion Intervalo de linea base del Administrador de estilos de
cota, en la ficha Lineas.
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3. Utilice una referencia a objeto para designar el origen de la siguiente
linea de referencia.

4. Continle para designar los origenes de la linea de referencia segln sea
necesario.

5. Pulse INTRO dos veces para terminar el comando.

Para hacer que las lineas de referencia sean oblicuas
1. Haga clic en el menu Acotar » Oblicua.
2. Designe la cota.
3. Escriba un valor para el angulo de inclinacion o designe dos puntos.

Tl AutoCAD 2008 - [C:\Users\MERCEDES\Downloads\plano_en_planta.dwg]
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Crear estilo de cota, Modificar estilo de cota y Reemplazar estilo actual:
— Ingresamos a Menu formato estilo de cota
— Establece las propiedades de los estilos de cota. Cuando pulsa Continuar
en el primer cuadro de dialogo Crear estilo de cota, se abre otro cuadro
de dialogo Crear estilo de cota. En €l se definen las propiedades del nuevo
estilo. Inicialmente, el cuadro de dialogo muestra las propiedades del
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estilo de cota que se ha seleccionado con el fin de iniciar el nuevo estilo
en el cuadro de dialogo Crear estilo de cota.
— Al elegir Modificar o Reemplazar en el Administrador de estilos de cota se
muestran los cuadros de didlogo Modificar estilo de cota o Reemplazar
estilo actual. El contenido de estos cuadros de dialogo es idéntico al del
cuadro de didlogo Crear estilo de cota, aunque en realidad se esta
modificando o sustituyendo un estilo de cota ya existente y no creando uno

nuevo.

— Laimagen que aparece como ejemplo en cada ficha muestra los efectos de

cada opcion.

M File Edit View Insert

Tools Draw Dimension Modify Express Window |

DWHEH 0D §S Lye.

[T Layer tools
IHA FHIO PE cobr.

Linetype...
Lineweight...
Scale List...

B Text Styl
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Plot Style...
Point Style...
Mutiline Style...

nits...

< Thickness

B-adHo01O0NL0LNN

X R | FED
EBylayer - || ByColor

Fg | By L | Stend

& Layer States Manager...

Don't list styles in Xefs

Description
Standard + Overall scale = 0.5000

Los cuadros de didlogo Crear estilo de cota, Modificar estilo de cota y
Reemplazar estilo actual incluyen las siguientes fichas:

Lineas

Lines | Symbols and Amows | Tet [ Fit

[ Primary Units | Atemate Units | Tolerances|

Dimension lines

Color:

Linetype:

; icht-
BExtend beyond ticks:

Baseline spacing:

— ByBlock -

o &
omm [

Suppress: [C] Dim line 1

[ Dim line 2

Calor: M ByBlock

Linetype ext line :  ——— ByBlock

Linetype est line 22— ByBlock

Lineweight: — ByBlock

[[] Ext line: 1

Suppress:

[[] Ext line 2
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Simbolos y flechas

Texto

Ajustar

s W )

]

EE BB«

L

Text alignmert

® Horizontal

() Aligned with dimension ine

(© 150 standard

T

I there isnt enough room to place both text and

amows inside extension lines, the first thing to
move outside the extension lines is:

(@) Either text or amows (best fit)

©) Amows.

© Text

(@) Both text and amows

(©) Always keep text between ext lines

[T Suppress amows if they dont fit inside:
extension lines

Texd placement
When text is not in the default position, place it:
@ Beside the dimension line:

() Over dimension line. with leader

(©) Over dimension line, without leader

Scale for dimension features

[ Annotative (1)
(7 Scale dimensions to layout
@) Use overall scale of:

Fine tuning

[ Place texd manually

[C] Draw dim line between ext lines

([ ok ] [ cacs | [ bHep |
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Unidades principales

[ Apply to layout dimensions only
Units format:

Zero suppression

[ Leading [7]0feet

[T Trailing [/] Dinches

Altemate Units | Tolerances |

0.0000

=]
=

1.0000 % Angular dimensions
Decimal Degrees. -
Precsn

Zero suppression

Unidades alternativas

[Lines [ Symbols and Arows [ Text | Fit

| Primary Units | Atemate Units | Tolerances|

Unit format:

Procisi

Display attemate units
Atemate units.

[Z] 0feet

[Z10inches

Tolerancias

Lines | Symbols and Amows | Ted | Fit

Tolerance format

Vertical position:

Zero suppression
[[Leading
] Traiing

Tolerance alignment
(@) Align decimal separators
(@) Align operational symbols

Primary Units | Atemate Units | Tolerances

0.0000
0.0000

1.0000

==

Zero suppression

- [ Leading Ofeet
Dfest

Oinches [ Trailing Dinches

DAII - UNP
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5.3.

5.4.

MATERIALES Y EQUIPOS

e Modulo AutoCAD
e Programa AutoCAD

EJERCICIOS RESUELTOS

Si desea acotar el ejercicio desarrollado en el capitulo anterior.

1.
2.

3.

5.5.

Debemos activar la capa cotas.

En ella escogemos el tipo de acotado segun las caracteristicas que se
muestran en la figura.

Activamos el administrador de acotado y entramos a modificar las
caracteristicas del acotado gque se necesita como:

e Los simbolos y las flechas de las cotas, el color texto, unidades, etc.
Luego de las modificaciones necesarias se define como actual y
cierra la ventana.

Se procede a colocar las cotas, segun sea el caso cota de lineas inclinadas o
cotas de lineas verticalesr u horizontales.

El acotado debe hacerse teniendo en cuentas normas bésicas del acotado
esto es respetando las normas internacionales, cumpliendo aspectos como
legibilidad y exactitud.

EVALUACION
140
I A —_— — - o
S
2 o
o
‘ L
?

100

130

=20
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CAPITULO VI
“Dibujos Isomeétricos”
6.1. OBJETIVOS

e Creacion de dibujos isométricos

6.2. FUNDAMENTO TEORICO

Los dibujos isométricos simulan un objeto 3D desde un punto de vista
particular alineandolo a lo largo de los tres ejes principales.

Al establecer el modo Referencia rejilla/Resolucion isométrica, podra alinear
objetos con facilidad a lo largo de uno de los tres planos isométricos; sin
embargo, aunque el dibujo isométrico parece estar en tres dimensiones, en
realidad es bidimensional. Por ello, no se puede esperar extraer distancias y
areas 3D, visualizar objetos de diferentes ventanas gréaficas o suprimir lineas
ocultas de forma automatica.

12 ooorggein S
Snap and Grid [ Polar Tracking | Obiect Srap | Dyniamic Inpu |
Snap On (F3)

[£] Grid On (F7)

Snap spacing
Snap X spacing

Snap Y spacing 0.5000
[] Equal X and Y spacing

Polar spacing

Folar distance:

Snap type
@ Grid snap
(@) Rectangular snap
(@ Isometric snap

Grid spacing
Grid X spacing
Grid Y spacing

Maijor line every:

Grid behavior
Adaptive grd
Allow subdivision below grid
spacing

Display grid beyond Limits
Follow Dynamic LICS

() PolarSnap

Si el angulo de referencia es 0, los ejes de los planos isométricos se situaran
a 30, 90 y 150 grados. Después de establecer el estilo de resolucién como

Isométrico, se puede trabajar con tres planos, cada uno asociado a un par de
ejes:

Izg. Alinea la malla y la rejilla con los ejes a 90 y 150 grados.
Arriba. Alinea la mallay la rejilla con los ejes a 30 y 150 grados.
Derecha. Alinea la malla y la rejilla con los ejes a 30 y 90 grados.
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Si escoge uno de los tres planos isométricos, Orto y los cursores en cruz se
alinearan a lo largo de los ejes isométricos correspondientes. Por ejemplo,
cuando el modo Orto esté activado, los puntos que designe se alinearan a lo
largo del plano simulado en el que se estd dibujando. Por tanto, podra
dibujar el plano superior de un modelo, cambiar al plano izquierdo para
dibujar otro lado y, finalmente, cambiar al plano derecho para completar el
dibujo.

Para activar un plano isométrico

Haga clic en el mend Herr. » Parametros de dibujo.

En el cuadro de didlogo Parametros de dibujo, en la ficha Resolucion y
rejilla, dentro de la seccion Tipo de referencia, seleccione Resolucion
isométrica.

Haga clic en Aceptar.

Puede pasar por tres planos isométricos pulsando F5.

Especifica el plano isométrico actual

Introduccion de comando: isoplano (o isoplano para usarlo de forma
transparente)

Indique parédmetro de plano isométrico [lzquierdo/Superior/Derecho]
<Superior>: Escriba una opcién o pulse INTRO
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El plano isométrico sélo afecta a las teclas de movimiento del cursor cuando
el modo de referencia a objetos se encuentra activado y el estilo de
resolucion es Isométrico. En este caso, el modo Orto utiliza el par de ejes
apropiado aunque el modo de referencia a objetos esté desactivado. El plano
isométrico actual también determina la orientacion de los circulos
isométricos dibujados mediante ELIPSE. Puede desplazarse ciclicamente
por los planos isométricos pulsando CTRL+E o F5.

Para dibujar un circulo isométrico

1.
2.

°oasw

Haga clic en el mend Herr. » Parametros de dibujo.

En el cuadro de didlogo Parametros de dibujo, en el area Tipo y estilo de
resolucion de la ficha Resolucion y rejilla, haga clic en Resolucién
isométrica. Haga clic en Aceptar.

Haga clic en el menu Dibujo » Elipse » Ejes, Fin.

Escriba i (de Isocirculo).

Especifique el centro del circulo.

Defina el radio o el diametro del circulo

o]
=
r
@
¢}
~
<o
>
w2l
Bl
=
=
m
A

[Command: ellipse
Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I
Specify center of isocircle:

A|Specify radius of isocircle or [Diameter]:
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Isocirculo: Crea un circulo isométrico en el plano de dibujo isométrico

actual.
Precise centro de isocirculo:
Precise radio de isocirculo o [Diametro]: Indique una distancia o escriba d

g

= e,
e ._'"'.

-1 T
- =
l"'.. D I.’l'_l'l
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6.3. MATERIALES Y EQUIPOS

e Modulo AutoCAD
e Programa AutoCAD

6.4. EJERCICIOS RESUELTOS

§
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1. Después de haber escogido el tamafio de hoja adecuado y las unidades
pertinentes, activar la rejilla en forma isométrica.

2. Usar la orden linea, con las ayudas de dibujo modos de referencia y ortho
para construir cada uno de los lados de la pieza. Para cambiar de lado segun
se va requiriendo Top, Rigth y Left se hace uso de la tecla f5.

3. Para construir los circulos se hace uso de la orden elipse opcion <i> de
isocirculo.

4. En el caso de redondeos de extremos se debe determinar el centro del
isocirculo.

5. Se complementan con las d&rdenes ya conocidas para dibujar
representaciones bidimensionales.

6. La orden Offset no se usa para la construccion de isométricos.

7. Los angulos en este caso tampoco son reales, por lo que se trabaja con los
catetos.

8. Cuando de hace el acotado, para una alineacion adecuada de la cota al
isométrico debe usarse la orden Oblique.
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6.5. EVALUACION
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CAPITULO VII

“Multilineas”

7.1. OBJETIVOS

e Creacion de dibujos haciendo uso de la orden multilinea.

7.2. EUNDAMENTO TEORICO

La orden multilinea permite dibujar lineas paralelas a una distancia
determinada y ademas da la posibilidad de hacer uso de distintos tipos de
linea.

Para crear una multilinea.- Activamos Draw en el menu principal y luego
Multilinea, posteriorme aparece la siguiente solicictud: specify start point or
[Justification/Scale/STyle]:

Luego se procede a dibujar de la misma manera que la orden linea.
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Editar el estilo de multilinea.- Para editar una multilinea activamos Format
en el mend principal y luego Multiline Style, posteriormente aparece un
cuadro de dialogo donde se pueden crear otros estilos de multilinea con la
opcion new, al activar esta orden aparece un cuadro de dialogo en el que se
agrega un nombre al estilo de multilinea que se va a crear, a continuacion
continuar, y se procede a modificar las propiedades como tipos de lineas,
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color, distancia entre cada linea y agregar dos tres o0 més lineas, segun lo
que se desee.

Para hacer uso de los estilos de multilineas creados, se debe activar
activando con la opcién Set Current.
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7.3. MATERIALES Y EQUIPQOS

e Modulo AutoCAD
e Programa AutoCAD
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7.4. EJERCICIOS RESUELTOS
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1. Después de haber escogido el tamafio de hoja adecuado y las unidades
pertinentes.

2. Configurar el tipo multilinea en la opcién formato, donde observamos que se
puede activar distintos tipos de linea, se puede dar la escala, color, etc.

3. Usar la orden multilinea, y ajustar la linea a top, botton y mid, con las
ayudas de dibujo modos de referencia y ortho para construir la pieza.

4. Este comando ayuda mucho para la construccién de los muros de pared para
los planos de casas en vista de planta.

7.5. EVALUACION

22X R 310

Figura 6.142 Trébel de carretera
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CAPITULO VIII

“Bloques”
8.1. OBJETIVOS

e Creacion de bloques

8.2. FUNDAMENTO TEORICO

Los dibujos muchas veces son repetitivos, sobre todo en el area de ingenieria
civil, cuando se desarrolla planos de viviendas se observa que hay elementos
tales como puertas, inodoros, ventanas, cocinas, sillas, camas, mesas, etc. Lo
que amerita que estos elementos sean insertados de forma mas rapida y
precisa. Autocad cuenta con la opcién de Block.

Para crear Blogues, debo dibujar el objeto que va a ser colocado en el
bloque para luego ser insertado las veces que sea necesario:

1. En Draw>Block >Make

2. Autocad muestra la ventana Block Definition

3. Colocamos el nombre del bloque, definir el punto base, el cual
puede insertarse dando coordenadas, sefialando un punto con el
puntero o precisando en la pantalla.
Designar los objetos que se colocaran en el blogue
Podemos dar también caracteristicas como las unidades del bloque,
la escala y si es un blogue compuesto o desintegrado.
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Como Inserta un bloque creado

1. Acceder al menu principal Insert > Block
2. Se muestra un cuadro de didlogo como el que se muestra
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Especifica el nombre del bloque a insertar

Luego se debe dar el punto de insercion, la escala y la rotacion.
Esto se puede tomar tal como se cred el bloque activando las
opciones que me permiten definirlo en la pantalla a la hora de la
insercion.

6. Luego Ok, y el bloque se insertara.

ok w

i AutoCAD 2008 - [Drawingl.dwg]
"N File Edit View [Insert| Format Tools Draw Dimension Mo

Eri=IEY. N - %

[y DWG Reference...

DWF Underlay...

DGM Underlay...

Raster Image Reference...
Field...

Layout

3D Studio...
ACIS File...
Drawing Exchange Binary...
Windows Metafile...

o OLE Object...

[ﬁ External References...

& Hyperlink...

AutoCAD — INGENIERIACIVIL -12 -



LABORATORIO DE AutoCAD DAII - UNP

8.3. MATERIALES Y EQUIPOS

e Modulo AutoCAD
e Programa AutoCAD

8.4. EJERCICIOS RESUELTOS

1. Después de haber escogido el tamafio de hoja adecuado y las unidades

pertinentes, activar la rejilla en forma isométrica.

Desarrolla el dibujo.

3. Posteriormente se procede a crear el blogue, con el nombre comedor,
indicando las caracteristicas como escala y punto de insercion.

4. Luego se podra insertar el bloque llamado comedor cada vez que uno lo

desee, para complementar planos de casas y habitaciones.

Lo mismo se puede hacer con los distintos muebles y enseres.

Autocad trae definidos bloque para insertar, esto facilita el trabajo.

7. Si desea personalizar sus muebles y enseres debe crear los propios.

no

o u
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8.5. EVALUACI

ON

El plano debe ser desarrollado haciendo uso de bloque para los elementos

que se repiten.
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Conclusiones

e La presente guia serd de mucha utilidad en el curso de Dibujo con
Ordenador para Ingenieros Civiles para lograr el aprendizaje adecuado de
los conceptos que se imparten en clase, por lo que aunque ha sido hecha de
forma tal que el alumno pueda auto capacitarse en algin momento sera
necesario el apoyo indiscutible del docente.

e La forma como ha sido estructurado el modulo y los ejercicios resueltos de
cada Capitulo, ayudaran al estudiante al mejor entendimiento en la
realizacién de los dibujos, asi como el aprendizaje paso a paso del curso.

e Los ejercicios propuestos, permitiran al estudiante practicar y con ello poder
afianzar los conocimientos impartidos.

e La presentacion de las pantallas de Autocad en el desarrollo del médulo,
permiten una mejor explicacion del mismo.
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Recomendaciones

e Para una profundizacion en el tema, sera necesario practicar de manera
agresiva, ya que ordenes mas profundas no se tocan en esta guia, y el alumno
las ir& descubriendo a medida que aprende y se inmiscuye en el tema.

e Que el presente trabajo, sirva de aliciente para que se desarrollen mas
moddulos en el resto de cursos, afin de que los estudiantes tengan mas
herramientas para un mejor aprendizaje.

e EIl estudiante, deberd desarrollar el modulo paso a paso, para que su
aprendizaje se realice de manera sencilla.
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